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THSDM Tutorial - Introduction

Purpose:

The purpose of this Tutorial is to provide users with a guided overview of the IHSDM
software. Upon completing the self-paced tutorial, the user should have a basic
understanding of the [HSDM software and its components, and experience in applying
IHSDM to evaluate the safety of a highway design.

The Tutorial does not cover all details of the software. For more information, the user is |
encouraged to refer to the IHSDM documentation, including the IHSDM Users Manual,
the Basic Services Engineer’s Manual and the Module Engineer’s Manuals.

To access the IHSDM documentation summary:
1. Go to the IHSDM main interface
2. Click on “Help” from the menu bar
3. Click on “User Documentation Summary™

 Structure:

 The Tutorial uses a case study approach to illustrate the functionality and applicability of
{IHSDM. Each lesson includes a brief Overview with links to related documentation, and
exercises that lead users through the software via step-by-step instructions. A work problem
panswer key is provided at the end of lessons 2-7 for questions posed in the exercises.

The Tutorial consists of:
- Introduction
- Lesson 1: Introduction to the IHSDM Pike Case Study
- Lesson 2: Overview of the IHSDM Basic Services
- Introduction to IHSDM Modules:
o Lesson 3: Policy Review Module
Lesson 4: Crash Prediction Module
Lesson 5: Design Consistency Module
Lesson 6: Traffic Analysis Module
Lesson 7: Intersection Review Module

o000

In Lesson 1, the case study is introduced. Plan/profile sheets help to familiarize the user

with IHSDM Pike — an existing highway used throughout the Tutorial to illustrate
IHSDM capabilities.

i Introduction
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In Lesson 2, the [HSDM “basic services” are introduced. Exercises lead the user through
steps to create an IHSDM Project, Analysis and Highway for IHSDM Pike, which are
prerequisites for the exercises in Lessons 3-7.

In Lessons 3-7, the exercises focus on running the THSDM modules to evaluate the safety
of IHSDM Pike and interpreting the output.

The lessons can be done in any order, with the exception that the Lesson 2 exercises (2.1, 2.2,
and 2.3) must be completed before beginning the exercises in Lessons 3-7.

“Tutorial* Folder Contents:

The IHSDM software home directory/folder contains a “Tutorial” folder, which includes:
- Index.html {a browser page that provides links to the IHSDM tutorial
documents, and to the adobe website)
- Tutorial_Table-of-Contents.pdf
- Tutorial_Intro.pdf (this file)
- Lessons files (7 PDF files):
e Includes step-by-step instructions for Lessons 1-7
(Tutorial_Lesson_#.pdf)
- “IHSDM_Pike-Pian_Profile” folder:
» Plan/profile views of IHSDM Pike (9 PDF files)
e Typical section for IHSDM Pike (1 PDF file)
- “Analysis_Reports” folder:
» [HSDM output files corresponding to each exercise, labeled as
“ExerciseX.Y_ ModuleName-Report.htm” (e.g.
Exercise 3.1 PRM_Report.htm)

petting Started with the Tutorial:

Before beginning the Tutorial, the IHSDM software should be installed and configured
(see “IHSDM Getting Started Guide” and “IHSDM Installation Manual®).

To begin the Tutorial with lesson 1 click on the “Go to the lesson 1” link below.

phack to: Table of Contents
bto Lesson |

2 Introduction
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Lesson 1: Introduction to the IHSDM Pike Case Study

 Lesson 1 introduces THSDM Pike - an existing 2-lane rural highway that serves as a case study
for the Tutorial. The lesson contains an overview of [HSDM Pike, and an exercise that examines

the horizontal alignment, vertical alignment and typical cross-section in more detail through a

review of electronic plan/profile sheets. Lessons 3-7 show how the [HSDM evaluation modules

- could be used to evaluate [HSDM Pike.

“ Overview of IHSDM Pike:

' [HSDM Pike is an arterial highway in rolling terrain. The State Highway Agency wants to
 identify potential safety and operational concerns on a 4.353 km section of the highway. Crash

history data for the years 1993-1995 indicate that the section has a crash rate higher than the
State average for 2-lane rural highways. The section to be analyzed has a design speed of 80
kmvh, relatively narrow 3.3 m (11 ft) lanes and no shoulders. The horizontal alignment is
generally curvilinear, including several compound curves and one reverse curve. Some sections
have steep (over 5%) vertical grades. Two intersections are located along [HSDM Pike. Near
the mid-point of the highway section is a five-leg intersection with Springfield Drive and Clinch
| Ave. Traffic control consists of stop control on the minor roads and no control on IHSDM Pike.
‘A second intersection is located towards the end of the alignment, where [HSDM Pike crosses
Route 1. This 4-leg intersection is skewed and signalized.

Summary:

Length = 4.353 km
Project limits: Station 0+000 to Station 4+353.00
Functional classification = Arterial
Terrain = Rolling
Design speed = 80 km/h
Cross-section:
» 3.3 m wide travel lanes
= No shoulders
o Average Daily Traffic (ADT):
= [n2001: 5000 vpd
= In2010: 7000 vpd (projected)
o Intersections:
= At Station 2+050: multi-leg (IHSDM Pike / Springfield Dr. / Clinch Ave.}
with stop control on minor roads
= At Station 3+920.12; skewed 4-leg signalized (IHSDM Pike / Route 1)

o0 000 o0

1 Lesson 1
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Work Problem

Exercise 1.1: Review IHSDM Pike

n this exercise, you will examine IHSDM Pike by reviewing electronic plan/profile sheets and a
ypical cross-section of the 4.3 km long analysis section. Continue by following the step-by-step
nstructions below.

L Review Plan/Profile sheets for existing IHSDM Pike

1. Go to the “Tutorial” folder within the IHSDM software

2. Go to the “IHSDM_Pike-Plan_Profile” sub-folder

3. Open ihsdmpike ex align.pdfto view a small scale plan/profile sheet of the
existing highway

4. If desired, open ihsdmpike pp#.pdf (where # = 1 thru 8) to view larger scale
plan/profile sheets of the existing highway

5. Close files when done

18 Review Typical Section for existing IHSDM Pike
1. Open ihsdmpike typ secl.pdf to view typical sections for existing IHSDM Pike

and Route 1
2. Close file when done

back to: Table of Contents
to the next lesson

2 Lesson ]
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Lesson 2: THSDM Basic Services

fLesson 2 reviews the IHSDM Basic Services. After an overview of the
Basic Services, exercises are provided to give hands-on experience in
using the [HSDM software. An [HSDM “Project” and “Analysis” are
preated for the IHSDM Pike case study. Highway data are entered via
mporting an existing dataset and by “manual” entry of data into the Edit
Highway interface.

_ he Project and Analysis created in this lesson are used in lessons 3-7.

iComponents of the IHSDM Basic Services

Bhe basic services are essentially the parts of the IHSDM software that are
pot safety evaluation modules. These services provide the means to create
HSDM “Projects” and “Analyses,” to enter and manipulate data, to set

ger properties/preferences, to access Help and documentation, and to

fiew the highway to be analyzed in a 2D graphics environment. A
onceptual representation of the IHSDM structure is shown below.

IHSDM BASIC SERVICES
Project / Analysis / Highway/s
Import / Export  User Properties

Edit / View Help /
Highway Data  Documentation

Admintool
Application

1
IHSDM MODULES

THSDM Turorial

Lesson 2
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Components of IHSDM Basic Services include:
1. The Project/Analysis/Highway structure

Import/editing/viewing of highway data

User properties

Help functions

Documentation

RS

An “Administration Tool” (provided with IHSDM as a separate
application)

The IHSDM user interface provides access to the Basic Services, as
well as all THSDM modules.

L Analysis 1 | AN Analysis 2
| (Existing Highway)

Review |

Review

THSDM Projects, Analyses and Highways:

An IHSDM Project is the top level of data organization, serving as
container for all data related to the safety evaluation of a highway.
A Project is analogous to a Windows folder or directory.

son 2
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One or more Analyses can be defined for a Project. An Analysis is
associated with a (Master) Highway, and defines the limits of the
evaluation.

Once a Project and Analysis are created, and a Highway associated
with the Analysis, one or more THSDM modules can be used to
evaluate the highway.

In this lesson, you will create a Project for IHSDM Pike, and an
Analysis for the existing highway.

IHSDM Highway Data:

[HSDM highway data fall into three main categories:
- Highway segments
- Intersections
- Crash history

Highway segment and intersection data include geometric and non-
geometric data.

[HSDM highway data can be viewed and edited via the IHSDM Edit
Highway interface.

Not all data are required for all modules. The Engineer’s Manuals and
the Edit Highway interface indicate what data are used/required by
each module.

See the “Basic Services Engineer’s Manual”, “Highway Model User’s
Manual”, “IHSDM Intersection Model Manual”, and “Highway
Element Manual” for detail on IHSDM Data.

THSDM Tutorial

To access the IHSDM
documentation summary:
1. Go to the IHSDM main
interface
2. Click on *Help” from
the menu bar
3.Click on “User
Documentation
Summary”

Lesson 2
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¢ GEOPAK-to-

User’s Manual:
¢ [HSDM main
¢

1*Help” from

u bar

n“User

entation

Jown and choose
MK -10-THSDM
gion

mmer's Interface
Jser's Manual”

Methods to Input Highway Data:
Highway data can be entered into [HSDM in several ways, including:

Through the IHSDM Edit Highway interface
Importing data files in IHSDM (CSV) format
Using the GEOPAK-to-THSDM Data Extractor, or
Importing LandXML files

S

Edit Highway interface

- The Edit Highway interface allows users to import highway
files that are in IHSDPM (CSV) or LandXML 1.0 format, or to
“manually” enter data. Once data are entered, the user can
view and edit the values.

GEQOPAXK-to-IHSDM Data Extractor

- The GEOPAK-to-IHSDM Data Extractor provides the ability
to extract horizontal alignment, vertical alignment and cross-
slope data from GEOPAK (GPK and INP) files. Data beyond
the edge of pavement (e.g., shoulder data, side slopes) cannot
be extracted from GEOPAK, but can be entered into [HSDM
“manually” through the Edit Highway interface.

Land XML

- LandXMLL.0 files can be imported directly into IHSDM.
LandXML is an XML-based data format for civil engineering
and survey design data used in the “Land Development
Industry,” including highway geometrics.

Land XML was developed by a consortium of civil design software
vendors, State DOTs, consulting firms and FHWA. The standard
format supports transfer of data between different vendor products,
and assists in archiving data for future use by the same
agency/organization.

Support for import of LandXML 1.0 data is provided within
[HSDM. Most IHSDM roadway segment data elements are
represented in LandXML. Some IHSDM intersection elements are
represented in LandXML, but not all. An IHSDM “export to
LandXML” capability may be added in the future.

The current versions of most major civil design vendor products
currently support LandXML, including Autodesk (CAiCE and

Lesson 2




Autodesk Land Development Desktop), Bentley Systems, Inc.
InRoads, GEOPAK, and MX), and Eaglepoint.

See www.landxml.org for more information about the LandXML
jata exchange standard, including a list of vendor products that
support the standard.

Jocumentation:
The five categories of IHSDM documentation are:

1. For system administrators — for individuals responsible
for installing, configuring and maintaining the software
(i.e., not for “regular” users). Documentation includes the
System Administrator’s Manual.

2. User’s Manuals — for the mechanics of installing and
using the software (e.g., “what does this button do?”).
Includes the [HSDM User’s Manual.

3. IHSDM Data — all data used in IHSDM are documented.
Includes IHSDM Highway Model, [HSDM Intersection
Model, LandXML Support, Highway Elements, and
GEOPAK-to-IHSDM Data Extractor.

4. Engineer’s Manuals — provide background on the
engineering models used within IHSDM, and help users to
understand and interpret results. An Engineer’s Manual is
provided for each module, as well as for [HSDM Basic
Services.

inistration Tool:

- [HSDM comes with a separate Administration Tool application for

- administrator-level users.The Administration Tool is a separate

- application (i.e., it is started outside of IHSDM and has its own
interface), which allows administrators to perform functions such

as:

1. Edit/maintain the policy files used in the Policy Review
and Intersection Review Modules. Organizations can
modify the AASHTO policy files resident in the software
to refiect their own policy. There are limitations, which are

2. Calculate, enter and edit calibration factors that scale the
Crash Prediction Module results to the data of a particular
State/Agency.

described in the Policy Review Module Engineer’s Manual.

THSDM Tutorial

Lesson 2
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3. Edit configuration files, which control items such as
parameters used in simulation models (e.g., the Traffic
Analysis Module)

4, Modify default values (e.g., for formatting THSDM
Analysis Reports)

Work Problem

In the work problem, you will use the IHSDM software to explore the
Basic Services:

Exercises:

- 2.1: Project/Analysis/Highway — Create a Project for IHSDM
Pike and an Analysis for Existing IHSDM Pike, and import
highway data for [HSDM Pike

- 2.2: User Properties -- Modify User Properties

- 2.3: Edit Highway -- Enter and review highway data via the
Edit Highway interface

- 2.4: Help/Documentation -- Access [HSDM documentation

- 2.5: Highway Viewer -- Open the Highway Viewer and view
[HSDM Pike




Exercise 2.1: THSDM Basic Services - Project/Analysis/Highway

. To start THSDM
1. Start [HSDM by double clicking the shortcut icon on the computer
screen
a. NOTE: By default, the “Project/Analysis/Highway Wizard”
opens automatically when [HSDM is run (the “Welcome to
THSDM? screen will appear). The default can be changed
through the “User Properties” interface.

b. For the purpose of this exercise, click on “Cancel” to close the
Wizard. The main [HSDM interface should appear.

[HSDM Tutorial

Lesson 2
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II. To create a Project/Analysis using the “Project/Analysis/Highway
Wizard”

1. Select “File> Project/Analysis/Highway Wizard” from the pull-
down menu

2. To create a new Project

a. On the “Project/Analysis/Highway Wizard” / “Select a Project”
dialog, click on the “New” button

b. Inthe “New Project Information” dialog, fill in and/or select:
o Project Name = “IHSDM Pike”
o Project Comment = “IHSDM Pike Evaluation”
o Project Unit System = Metric
o Station Notation = X.ZZZ7
o Click on “Save”

. On the “Project/Analysis/Highway Wizard” dialog, click on the
“Next” button




3. To create a new Analysis:
a. On the “Project/Analysis/Highway Wizard”/ “Select an
Analysis” dialog, click on the “New” button

b. Inthe “New Analysis Information” dialog, fill in and/or select:

O

@IHEY @EIE R

New Analysis Information

Analysis Name = “Existing [HSDM Pike”

Analysis Comment = “Existing [HSDM Pike Evaluation”
Analysis E Max (%) =8

Default Normal Cross Slope (%) =-2.00

Analysis Year = 2004

Click on “Save”™

L

sting IHSOM Pike
sting IHSDM Pike Evaluation

c. On the “Project/Analysis/Highway Wizard” dialog, click on the
“Next” button

IHSDM Tutorial

Lesson 2
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k=) [Project | Analysrs | Highway] Wizard

158

4. To import highway data for Existing IHSDM Pike and associate

the highway with the “Existing [HSDM Pike” Analysis:

a. On the “Project/Analysis/Highway Wizard”/ “Select a Master

Highway” dialog, click on the “Import” button

b. On the “Highway Dataset Import Wizard” dialog, under “File

Selection,” find the “Highways” folder by using the “Look In”

field to browse

c. Click on the Tutorial-ihsdmpike.txt file. The name should

appear in the “File Name” field

D) example_anz.uxt

) example.txt

Tuoratlhsdmpietd |

D) Tutortatinsampike_data_exercise.txt

d. Click on “Next”

Lesson 2

10
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e. On the “Highway Dataset Import Wizard” dialog, under
“Import File Name,” click to highlight the row for Highway

Name = “ihsdm pike”

Minor road

aringfleld dr 3 ‘Minor Road
EERTAlE O B s 5 SRS - s jedsting roacway design

Unspecifisd

f. Click on the “Finish” button
g. On the “Select a Master Highway” dialog, click to highlight
“thsdm pike”

. Filg
inor road Clinch_sve
ur

swew O Minor Road X
; dwayte..inone ihedm, pike

routet

|

h. Click on the “Finish” button

Lesson 2
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5. The Project, Analysis, Master Highway and Analysis Limits fields
should now be filled in.

6. For this exercise, please select “SU- Single Unit Truck” as the
design vehicle.

Your screen should look like this now:

Loading highway Springfield dr

{Loading highway route1 i
Imparting Intersections definitions :
Selecting highway dataset insdm pike b

Lesson 2 12
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Exercise 2.2: IHSDM Basic Services - User Properties

I. Edit User Properties

1. Select Edit>Edit User Properties from main menu
2. Select “General” tab

- 3. Set “Program Startup” to “Start with none” (Note: this will start an
empty main interface every time IHSDM is started)

4. Set “Highway Element Checking/Query User” to “None” (Note:
this will prevent [HSDM from querying for missing data
elements);

13 Lesson 2
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Lh

Select “Reporting™ Tab

Set “Segment Conditional Display” to “Show All Elements”
(NOTE: this affects how Policy Review Module results are
displayed) ;

Set “Start New Report” to “For new safety analysis” (Note: a new
report file will be generated for each “run” of analysis.)

162

UHSDM\Tutorialtemplatesireport_htm.template

Lesson 2

14
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Lesson 2

15

8. Select “Data Entry” Tab, set “Table Editing” to “Edit Data by
row”. This would provide a separate window for each row of a
table when you edit the table.

User Properties
9. Click “Save”
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Exercise 2.3: IHSDM Basic Services - Edit Highway

I. To View Highway Segment Data:
1. Click on the “Edit the current highway” button (second from the
left) to open the Edit Highway interface

No errors

2. Use the tabs to scroll through the highway data for IHSDM Pike
e Q 2.3.1: Find the values for the following:

i

il
iii.
iv.

Design Speed (General>Speed>Design tabs)

ADT for 2001 (General>Volumes>Daily tabs)
Through Lane Width (Lane>Thru tabs)

Shoulder Width (Cross Section>Shoulder>Definition
tabs)

Design Speed

ADT (2001)

Through Lane Width

Shoulder width

(%)

Click on the “Horizontal” tab

4. Double-click on any row with Element Type = “Simple Curve” to
bring up the “Add/Edit Simple Curve” dialog

* Q23.2: What are the radii of the curves that begin at stations
1373.877 and 1391.33?

Curve Start Station

IBe8 7T

1391.330

wn

Click on the “Cancel” button

6. Click on the “Vertical” tab

Lesson 2

16



7. Double-click on any row with Element Type = “VPI” to bring up
the “Add/Edit VPI” dialog

e (Q2.3.3: For the vertical curve with VPI at station 1300, what is
the length of vertical curve (Back Length + Forward Length)?
Back Grade? Forward Grade?

Length of Vertical Curve (m)
Back Grade (%)
Forward Grade (%)

8. Click on the “Cancel” button
9. Click on “File->Don’t Save and Close” to exit the “Edit Highway”
interface

Il. To Enter/Edit Highway Segment Data

[n this exercise, you will first import data for a section of IHSDM Pike
(Station 614.932 to 4353.06), then add data for the section from Station
0.000 to 614.932.

1. To import a highway data file for the portion of IHSDM Pike from
Station 614.932 to 4353.06:

a. Choose “File/Import Highway/I[HSDM Data (CSV/XML)”
from the IHSDM main interface

I (Pubhic Test v2.07(-0409DA) [Projeck THSDM Pics | Anafpsis: Eristing IS Pt

Tighway route
ding highway route1
{marting intersections definitions
taring highway editor for Ihsdm pike
Relbading highweay Ihsam pike

b. Select “Tutorial_ihsdmpike data_exercise.txt” from the file list

IHSDM Tutorial
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[ 1

c. Click on “Next” to bring up the “Highway Dataset Import
Wizard”

taghway Dataset tmport Wizard

@o 3%

Clinch Ava Minor road

Springfleld dr Minor Road
R P : T
utel

on “Finish”.
e. Click on the “Edit the current highway” button to open the Edit
Highway interface

2. To add/edit highway segment data through the IHSDM Edit
Highway interface:

a. Click on the “General” tab

b. Click on the “Speed” tab, and then on the “Posted Speed” tab.

5501 2 18




No errors

c. There was no data specified for posted speed on IHSDM Pike
in the imported highway file. Click on the “Add” button to
bring up the “Add/Edit Posted Speed” data entry window

d. Fill the table as follows:

Start Sta. 0.000
End Sta. 4353.060
Side of Road Both
Speed Limit (km/h) | 80

e. Click on “Save”

f. Select “File/Save” from the pull-down menu to Update your
dataset.

ITHSDM Tutorial
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To add highway segment data by using Data Entry Assistant Tool
to enter, then copy/paste data from a spreadsheet file:

a. Click on the “Horizontal” tab in the Edit Highway interface.
Notice that the first horizontal element (Tangent) starts at
station “614.932”. You will add the horizontal element data
from 0.000 to 614.932 in this exercise. Keep the Edit Highway
interface open.

TesST

S LI RO e TR

S e
1128815
1217.657.

1372877

No etrors

b. Click on the link below to open a plan/profile view of I[HSDM
Pike, using the forward and back buttons in the PDF interface
to switch between this tutorial and the plan/profile as you
desire.

ihsdmpike ppl.pdf

This file provides all the information needed to fill-in the
missing data for IHSDM Pike (which you will do in the
following steps)

Lesson 2
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¢. Go to the IHSDM main interface and select “Tools/Data Entry
. Assistant” from the pull-down menu.

THSDM Tutorial

Lesson 2
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lion if you are first
ifthe DEA.

he documentation:
thie [HSDM main

o “Tool/Data Entry
t* from the menu

in“Help” on the
Assistant

d. Click on the “Horizontal Alignment” button, to create and open
a spreadsheet that will assist in entering horizontal alignment
data. The next screen provides a default name and directory to
store the data entry spreadsheet you are about to open. Accept
the defaults by clicking “Select”.

| Create and open-a Data Entry A

e. Click on “Enable Macros” when prompted.

Microsoft Excel

f.  The data entry assistant spreadsheet should now be open.
Review the “Readme” sheet and then go to the “Horizontal-
All” sheet by clicking the tab at the bottom of the spreadsheet.

Lesson 2
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IHSDM "Edit/View Highway Data" interface, honzontal alignment dements are further organized into type groups as "Tangent", "Simple Curve®, "Spiral L
eflectian”, “Heading”, and “Caordinates”. This table contains all horizontal alignment dements supported by IHSDM. Examgple of these edements and their atinbutes are
ven in the first few lnes of the table. "N/A™ indicates thal the altnbute is nol applicable o this dement. Users can simply leave it blank while fillimg m the Lable

fler filing i Lhis table, click on Lhe *Organmng” bullon, and the spreadsheet wll aulamatically organize Lhe dala mio separate Lables n the worksheets beed
angent’, "Simple Curve®, "Spiral Curve”, "Deflection”, "Heading®, and "Coordinates." Users can then copy/paste data from these sheets into the corresponding tables
the [HSDM "Edit/View Highway Data® mterface.

Curve”,

1 [Horizontal (Horlzontal

Start
Station

End Station | Station

Curve |Direction of [ Radius
curve

Radius

{Start filling in yout dita Trom Row 11,

Deflection Angle | Heading
(di (deg) Coordinates

Azimuth

Northing

Easting
Coordinates

IHSDM Tutorial

g. Fill in the form starting on Row 11 using the IHSDM Pike
plan/profile pdf file you opened previously (use the forward
and back buttons to switch between the tutorial and the
plan/profile) to gather the information you need. Did you get
the same data items as those in the table below?

- e e e e N .
0.000 10.000

10,000 83.304 200 Left

83.304 183.304

183.304 352.208 395 Right

352.208 502210

502.210 542.210 500 Left End

542.210 574.932 500 Left

574.932 614.932 500 Left Start

h. After you fill in the data form, click on the “Organizing” button

within the spreadsheet. This will automatically organize the
data into separate sheets according to the element type.

Go to the “Tangent” sheet, highlight the data cells (3 rows),
and click on “Edit/Copy™.

23
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Horizontal Alignment -Tangent

Start Sta. - The value of this item is the starting station for this highway ar design element.

End Sta. - The value of this tam is the ending station far this highway or design element.

{Tangent
Start Station End Station

OO T T

4

J. Return to IHSDM “Edit Highway” interface, click on the
“Edit/Add” button and choose “Tangent”

Heading L
| | {Tangent 614.832 636,005/
- Simple Curve = 696,005 765817

R R . JEEEIT
876.269
1006.264
1120818
1217657
1373877

No errors

k. Highlight any line, right click and choose “Clipboard/Paste
Rows”

esson 2
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S add/EdiE Tangent

514932
. 876.269
1217 857
1432.690,
2031472
2434313,
2TTSECTE S

. The data that you just copied from the spreadsheet are now
pasted into the table. If you do not see the data, scroll up or
down to find them. Or, click on the column heading of “Start
Sta” to sort the rows, to find the added rows.

m. Click on “Save” to close the “Add/Edit Tangent” window.

n. Now repeat the process for “Simple Curve” and “Spiral Curve”
(similar to steps i — m) by copying the data cells in the
spreadsheets and pasting into the corresponding Edit Highway
interface.

0. Once you have added all the data into IHSDM, select
“File/Save” from the Edit Highway interface pull-down menu.
On the “Horizontal” tab, you should see the horizontal element

information from station 0.000 to 4353.06.

0,000,
0.000
10.000
93,304
LRI
352,208
502.210
L L e i s s
574932

Export this data file by choosing “File/Export” from the pull-
down menu, then naming the output CSV Text file
“My_ihsdmpike.txt” in the default directory. Click on “Export”

Close the “Edit Highway” interface.
Dismiss the Data Entry Assistant interface.

Close the Horizontal alignment (data entry assistant)
spreadsheet, save the changes for future reference.

25 Lesson 2
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t. To ensure that you have the correct highway dataset for the
following lessons, in this exercise we will reload the complete
IHSDM Pike Highway dataset. Forgot how to do it?

i. Select “File/Import Highway Data/[HSDM Data
(CSV/XML)” from the ITHSDM main interface pull-
down menu

ii. Select “Tutorial ihsdmpike.txt” from the file list

iii. Click on “Next” to bring up the “Highway Dataset
Import Wizard”

iv. Make sure IHSDM Pike is the highlighted highway,
and click on “Finish”.

v. Click on the “Edit the current highway” button to open
the Edit Highway interface

IIL. To View/Edit Intersection Data:
1. Click on the “Edit Intersection...” button (second from left) to
open the Edit Intersections Interface. The “Intersections for base
highway (ihsdm pike)” dialog should appear.

D intersections fur base highway [ihsdm pi

o ( 2.3.4: Regarding the first intersection on IHSDM Pike:
i. At what station is it located?
it. How many legs does the intersection have?
iii. What type of traffic control?

Intersection location
Number of legs
Traffic control

Lesson 2 26



2. Highlight the intersection name and select Edit. The “Edit
Intersection Data™ dialog should appear.

2050.000:NE Clinch Ave i -B6.43263 simpla curve
2050.000:8E ihsdm plke 0. simple curvs
 050,000:8/ Clinch Ave 6260000 o AR stop simple curve

3. Highlight leg 1 and select “Edit.” The “Edit intersection leg data
for N Springfield Dr.” dialog should appear
4. Select the “Traffic Attributes” tab

s 02.3.5: What is the percentage of vehicles turning left onto SE
[HSDM Pike (shown in the “Traffic Turn Data” section of the

IHSDM Tutorial

dialog)?
% of vehicles turning left
onto SE IHSDM Pike from N
, Springfield Dr.
2] Lesson 2
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. Click the “Cancel” button on the “Edit intersection leg data for N

Springfield Dr.” dialog

. Click the “Cancel” button on the “Edit Intersection Data” dialog
. Click the “Cancel” button on the “Intersections for base highway

(ihsdm pike)” dialog

. Close the “Edit Highway” interface by selecting “File> Close”

from the pull-down menu

176
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Exercise 2.4: IHSDM Basic Services - Help/Documentation

I. Access Help/Documentation

1. Access the IHSDM User Documentation Summary via the Help
pull-down menu

g hig!
importing Intersections definitions
Starting highway editor for ihsdm pike
Reloading highway insdm pike

2. Open the “IHSDM User’s Manual” using the link in the [HSDM
User Documentation Summary.

3. Close the “IHSDM User’s Manual” by selecting “File”> “Close”
from the pull-down menu
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4. Use the “Search Master Documentation Index” function:

a. Select Help->Search Master Index

b. In the “Search Master Documentation Index” dialog, type
‘crash’ in the “Search Keywords” field

c. Click on the “Search” button

d. Click on the highlighted text to display a document referencing
‘crash’

e. Click on ‘Dismiss’ to close the dialog

f. Close the document you opened.

{crash Data tab, in Highway Elements Manual
Crash History Data list box, in Basic Services Module Engineer's Manual

Crash History Data list hox, in Basic Services Module Engineer's Manual

Crash History Data list box, in Highway Elements Manual

Crash Prediction Module calibration, in CPM Calibration Tool User's Guide
Crash Prediction Module manual (engineer's), in Crash Prediction Module Engineer's Manual
Crash Prediction tab, in Basic Services Module Engineer's Manual

Crash Prediction tab, in Basic Services Module Engineer's Manual

Using crash history data, in sSe dule En r's Man
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Exercise 2.5: IHSDM Basic Services - Highway Viewer

1. Open the Highway Viewer using the icon on the main interface
(sixth from left) .

2. Examine the plan and profile by choosing the respective tabs

3. In Plan View, zoom in on the first intersection by holding down
the right mouse button and dragging to form a rectangle (when
button is released, view will zoom to show extent of rectangle)

4. Zoom out to full view by selecting the fourth icon from the left.

Exit the Highway Viewer by clicking “File->Close” from the menu.

Exit THSDM by clicking “File->Exit IHSDM” from the menu.
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Lesson 2 Work Problem — Answer Key

Exercise 2.3

Q 2.3.1: Find the values for the following:
i. Design Speed (General>Speed>Design tabs)
ii. ADT for 2001 (General>Volumes>Daily tabs)
iii. Through Lane Width (Lane>Thru tabs)
iv. Shoulder Width (Cross Section>Shoulder>Width tabs)

Design Speed 80 km/h
ADT (2001) 5000 vpd
Through Lane Width 331m
Shoulder width 0.0 m

0 2.3.2: What are the radii of the curves that begin at stations
1373.877 and 1391.33?

Curve Start Station Radii (m)
1373.877 100
(3013310 150

Q 2.3.3: For the vertical curve with VPI at station 1300, what is
the length of vertical curve (Back Length + Forward Length)?
Back Grade? Forward Grade?

Length of Vertical Curve (m) | 250 m
Back Grade (%) -2.0%
Forward Grade (%) 7.0%

Q 2.3.4: Regarding the first intersection on IHSDM Pike:
. Atwhat station is it located?
it. How many legs does the intersection have?
iii. What type of traffic control?

Intersection location 2050.000
Number of legs 5
Traffic control Stop

0 2.3.5: What is the percentage of vehicles turning left onto SE
IHSDM Pike (shown in the “Traffic Turn Data” section of the
dialog)?

% of vehicles turning left onto SE 15%
IHSDM Pike from N Springfield Dr.

Go back to: Table of Contents

Go to the next lesson

Lesson 2
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Ga back to: Table of Contents
Go to the next lesson

Lesson 3: Policy Review Module (PRM)
Overview

The basic functionality of the Policy Review Module is to automate the
process of checking geometric design elements against relevant design
policy documents.

For more details, see the Policy Review Module Engineer’s Manual.

In the work problem, you will use the Policy Review Module to check
several geometric design elements of THSDM Pike against 2001 AASHTO
“Green Book” policy.

Work Problem

Exercise:
- 3.1: Evaluate Existing IHSDM Pike

See the flowchart below for a summary of the work problem.

IHSDM Tutorial

To access the Policy Review
Module Engineer’s Manual:

1.Go to the ITHSDM main
interface

2. Click on “Help” from
the menu bar

3. Click on “User
Documentation
Summary”

4. Scroll down and choose
the Policy Review
Module (PRM)

Engineer’s Manual

Lesson 3
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PRM work problem workflow:

[ Start an IHSDM Analysis J

|

[ Set the PRM analysis attributes ]

e Project type

f Select AASHTO Policy ]

{ Select desired check items ]

v

r Run PRM Analysis ]

Y
[ Interpret PRM output ]

182
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Exercise 3.1: Evaluate Existing IHSDM Pike

L. Open the “Existing IHSDM Pike” analysis

1. Start IHSDM by double clicking the shortcut icon on your desktop Set the PRM analysis
screen attributes
* Project type
2. To open the “IHSDM Pike” Project: ¥
a. Select File>Project>Open Project from the pull-down LSC‘“‘ AASHTO P"“Cﬂ
menu v
b. Click on the “IHSDM Pike” Project [ Selotdesired ek iems |
¢. Click the “Select” button v
[ Run PRM Analysis 7
3. To open the “Existing [HSDM Pike” Analysis: v
a. Select File>Analysis>Open Analysis from the pull-down L Interpret PRM output 7
menu

b. Click on the “Existing [HSDM Pike” Analysis

c. Click the “Select” button (the Project, Analysis and
Highway information should be visible in the main
(Project/Analysis/Highway) interface

Loading highway route 1 [—
Loading highway Clinch Ave

Loading highway Springfield dr

Lesson 3
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\.'\ [HSDM Analysis

o

i

ki AASHTO Policy

tdesired check items
{inPRM Analysis

kpret PRM output

IHSDM Tutorial

II. Setting the PRM analysis attributes

1. From the main (Project/Analysis/Highway) interface, choose the
“Modules” tab, then the “Policy Review” tab

2. Select the “Attributes™ sub-tab. Set the “Type of Project/Study” to
“reconstruction.”

Imparting highway route 1 F
Reloading highway elements fram CNHSOM\Tutorianusers\HAWANGUHSDM_Pikevroadway route 1.biob
Reloading highway route1

Reloading highway routet

Importing Intersections definitions

III. PRM Evaluation
1. Select the “Evaluation” sub-tab

ey

Sy

{importing highway Toute T
 Reloading highway elements from c:\lHSDM\Tumrlanuser:\HAWANG\IHSDM_PM\mau«av,rm.rte1 blob
i Reloading highway route1

i Reloading highway route

{ Importing intersections definitions

Lesson 3
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2. From the “Policy” tab, click on the “Choose or Change Policy” [ Start an IHSDM Analysis
button v
a. Select “AASHTO 2001 Metric” Set mi{fﬁé‘:t:galym
b. Click on the Select button D
HTO 1980 HTO 1990 Palicy (English)
JSHTO 1954 ASHTO 1834 Policy (Mstic)
AMSHTO 2001 English AASHTO 2001 Palicy (English) [ Select desired check items ]
P00 et
¥
[ Run PRM Analysis ]
¥

[ Interpret PRM output ]

3. To select the desired check items:

: Start an [HSDM Analysis 1
a. Select the “Cross Section” tab

- ¥
Select “Traveled Way Width” and “Shoulder Width” checks Set the PRM analysis
by clicking in the box to the left of the check name At
e Project type
¥

[ Select AASHTO Policy l

[ Run PRM Analysis ]

L2
[ Interpret PRM output ]

The check items are
organized in 4 groups:

* Cross Section

» Horizontal Alignment

Imparting highway routel E ? - : it . 1 1

Reloading highway elements from C:UHSDM\Tutorialusers\HAWANGIHSOM_Pike\roadway routet blob V'ertlca[‘ Ahgnment

Reloading nighway route1 e Sight Distance

Reloading highway route1 .

Ingirting Intersections definitians - Each group is represented by
one sub-tab under PRM
Evaluation

Lesson 3
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b. Select the “Horizontal Alignment” tab
Select “Radius of Curve,” “Superelevation,” and “Length of
Curve” checks by clicking in the box to the left of the check
name
k items are
din 4 groups
55 Section
nizontal Alignment
itical Alignment
t Distance e et
up is represented by Reloading highway elements fram C-NHSDMTUtariahusers\HAWANGNHSOM_Pikevroatway raute 1 biob
b under PRM Reloning gty ot
Importing Intersections definitions

¢. Select the “Vertical Alignment” tab

Select “Tangent Grade” and “Vertical Curve” checks by
clicking in the box to the left of the check name

Eo e D i i

Himporting Righway route 1
Reloading highway elements from C:UHSDM\TutorialusersHAWANGAHSDM_Pikevroadway.route 1 blob il
Reloading highway route1
Reloading highway route1

Importing intersections definitions

Lesson 3 6
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d. Select the “Sight Distance” tab
Select “Stopping Sight Distance” and “Passing Sight
Distance” checks by clicking in the box to the left of the
check name

T

W Distanca

A - : : :
Importing highway route &
Relozding highway elements from CAHSDM\TUtOraNusers\HAWANGYHSOM_Plke\roadway route1 .biah
Reloading highway route1

Reloading highway route 1

Importing Intersections definitions

4. Select the “Policy” tab and choose “Run All Selected PRM
Checks”. When finished, a “PRM analysis finished” message
would appear in the bottom status window.

SR

Imparting highway route
{Reloading highway elements from C:UIHSDM\Tutorialusers\HAWANGUHSOM_Pike\roadway route 1.biob
{Reloading highway route1

{Reloading highway route1

ilmporting intersections definitions

IHSDM Tutorial

The check items are
organized in 4 groups:

» Cross Section

e Horizontal Alignment

e Vertical Alignment

e Sight Distance
Each group is represented by
one sub-tab under PRM
Evaluation

[ Start an ITHSDM Analysis
v

Set the PRM analysis
attributes
* Project type

v
Select AASHTO Policy

¥

Select desired check items

[ Interpret PRM output ]

Note: the “Run All
Selected PRM Checks”
button located on the
“Policy” tab will run all
the checks that are
selected in the 4 other
sub-tabs (e.g., Cross
Section).
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futan IHSDM Analysis

Set the PRM analysis
attributes

Pro;ecl type

Select A.ASHTO Policy

lect desu’ed check items

Run PRM Analysis

|
]
)
]

IV. View/Interpret PRM Output
1. When the PRM is finished running (it will take a minute or two),
select “View Current Analysis Report”

IHSDM Analysm Report j

THSDM Version: 2 07£-040906, (Dady) on thsdm _test3
Date: Sep 13, 2004 1:44:46 PM

Name: (HAWANG)

Organization: GDL

Telephone:
E-Mail:

Project: IESDM Pike (IHSDM Pike Evaluaton)
Analysis: Existing [HSDM Pike (Exdsting [HSDM Pike Evaluation)
Highway Information: ihsdm pike, chain none (existing roadway design, fle: hsdm_pike)

Table of Contents

Analysis Report Index
1. Paolicy Review Module
1.1 Traveled Way Width Policy Check
Table: Traveled Way Width and Widening
1.2 Shoulder Width Policy Check
Table: Shoulder Width
1.3 Radius of Curve Policy Check
‘Table: Radus of Curve
1.4 Superclevation Policy Checle
Table: Superelevation
1.5 Curve Policy Checle
Table: Computed Curve Length
6 Tangent Grade Policy Check
‘Table: Tangent Grade
1.7 Vemcal Curve Policy Check =l
e T fanciimont: Gonn 5 3 T i LT L I )

2. After the Analysis Report opens, scroll down to the results for the
Radius of Curve check (or click on the “Radius of Curve Policy
Check” link in the Table of Contents)

»  Q 3.1.1: Which two curves have the lowest Effective Design
Speed?

Begin Station of End Station of Curve | Effective Design
Curve Speed (km/h)

3. Scroll down to the results for the Vertical Curve check (or click on
the “Vertical Curve Policy Check” link in the Table of Contents)

= Q3.1.2: Which two vertical curves have the lowest Effective

Design Speed?
Begin Station of | End Station of Effective Design
Vertical Curve Vertical Curve Speed (km/h)

Lesson 3



4. Scroll down to the results for the Stopping Sight Distance check

(or click on the “Stopping Sight Distance Policy Check” link in the

Table of Contents)

=  Q3.1.3: In each direction of travel (decreasing and increasing),
identify the segment with the shortest available Stopping Sight

THSDM Tutorial

Distance:

Direction | Begin End Available | Required

of Travel Station of | Station of | SSD (m) SSD (m)
Highway | Highway
Segment | Segment

Decreasing

Stations

Increasing

Stations

5. Close the Analysis Report by selecting “File > Close” from the
pull-down menu.

Exit THSDM

Lesson 3
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Lesson 3 Work Problem — Answer Key

Exercise 3.1

Q 3.1.1: Which two curves have the lowest Effective Design

Speed?

g Begin Station of End Station of Curve | Effective Design
% - Curve Speed (km/h)
1 ol unde 1373877 391330 54
IHSDM directory. 3210.677 3289.259 54
0S¢
greise_3.1 PRM
g 0 3.1.2: Which two vertical curves have the lowest Effective
Design Speed?
Begin Station of | End Station of Effective Design
Vertical Curve Vertical Curve Speed (km/h)
2250 2350 50
2450 2550 40

* Q3.1.3: In each direction of travel (decreasing and increasing),
identify the segment with the shortest available Stopping Sight

Distance:
Direction Begin End Available | Required
of Travel Station of | Station of | SSD (m) SSD (m)
Highway | Highway
Segment | Segment
Decreasing | 3076 3240 62 130
Stations
Increasing | 3104 3264 56 130
Stations

Go back to: Table of Contents
Go to the next lesson
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Go back to: Table of Contents
Go to the next lesson

Lesson 5: Design Consistency Module (DCM)

Overview

The Design Consistency Module evaluates opéfating speed consistency
through a speed-profile model that estimates expected 85th percentile,
free-flow, passenger vehicle speeds along a highway.

To access the Design
Consistency Module

Engineer’s Manual:

For more details, see the Design Consistency Module Engineer’s Manual.

In the work problem, you will use the Design Consistency Module to 1.Go to the THSDM main

evaluate the operating speed consistency of ITHSDM Pike. interface

2. Click on “Help” from

the menu bar
Work Problem 3.Glco
Documentation

: Summary”

Exercise: 4.Scroll down and choose
- 5.1: Evaluate the Design Consistency of IHSDM Pike the Design Consistency

Module (DCM)

Engineer’s Manual

See the flowchart below for a summary of the work problem.

1 Lesson 5
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DCM work problem workflow:

L Start an IHSDM Analysis

y

Set the DCM analysis attributes
®  Analysis vehicle
¢ Desired speed
®  Speed at start/end stations

!

[ Select DCM review items J

'

Run DCM Analysis 1

L Interpret DCM output J

Lesson 5
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Exercise 5.1: Evaluate the Design Consistency of Existing IHSDM
Pike

I. Open the “Existing ITHSDM Pike” analysis

Set the DCM analysis

1. Start [HSDM by double clicking the shortcut icon on your desktop e
screen ] Ana.lysis vehicle
2. To open the “IHSDM Pike” Project: i
: 5 £ peed at start/end
a. Select File>Project>Open Project from the pull-down stations
menu
b. Click on the “IHSDM Pike” Project [Select DCM review itemﬂ
c. Click the “Select” button ¥
3. To open the “Existing IHSDM Pike” Analysis: [ Run DCM Analysis ]
a. Select File>Analysis>Open Analysis from the pull-down
menu FnterprelDCM output ]

b. Click on the “Existing [HSDM Pike” Analysis

¢. Click the “Select” button (the Project, Analysis and
Highway information should be visible in the main
(Project/Analysis/Highway) interface

sussscasn s v

. Design Vehicle

PRM analysls finished

Crash Prediction Module Version: 1.01b (CPM Sep 01, 2004)

Proposed Highway: insdm plke, chain none( existing roadway design, blob insdm_pike )
CPM analysis finished successfully

%) Lesson 5
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[Stan an IHSDM Analysis] II. Setting the DCM analysis attributes

1. From the main (Project/Analysis/Highway) interface, choose the
“Modules” tab, then the “Design Consistency” tab
2. Select the “Attributes” sub-tab:
a. Verify that the “DCM Analysis Vehicle” is “Passenger Car —
- Type 57 (the vehicle type that represents the most common

Select DCM review “‘"“ﬂ passenger car). If not, click on the “Change DCM Analysis
¥ Vehicle” button and select “Passenger Car — Type 5.”

[ Run DCM Analysis ] b. Verify that the default value of 100 km/h is entered as the
= Desired Speed for the entire analysis section, and that the

[ Interpret DCM output ] Speed at Analysis Start Station and Speed at Analysis End

Station are 100 km/h.

PRM analysls finished
Crash Prediction Module Version: 1.01b (CPM Sep 01, 2004) _
# Proposed Highway: Ihsdm pike, chain none( existing roadway design, blob Ihsdm_pike ) 42

| CPM analysls finished successfully f‘ i

{tan [HSDM Analysis III. DCM Evaluation
1. Select the “Evaluation” tab
5‘“‘“: 5&‘5‘;‘:&'3‘5'5’ 2. Verify that both “Review Checks” are selected (checked)
* Analysis vehicle
+ Desired speed
+ Speed at start/end
stations

Run DCM Analysis

Iterpret DCM output

Lesson 5 4
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For details regarding
the review items, please
refer to the DCM
Engineer’s Manual

Crash Prediction Module Version: 1.01b (CPM Sep 01, 2004)

Proposed Highway: ihsdm pike, chain none( existing roadway design, blob ihsdm_plke )

CPM analysis finished successfully

3. Click on the “Run Selected DCM Checks” button to run the DCM ﬁan an [HSDM Analysis]
2

When finished running, a “DCM Completed” message will appear Set the DCM analysis
in the bott tatu i attributes
In the bottom s S reporting area. e Analysis vehicle

e Desired speed
= Speed at start/end
stations

v

[Selecl DCM review items]

[ Interpret DCM outpuj

IV. View/Interpret DCM Output

[Start an IHSDM AnalysisJ

1. Generate a DCM graph outside of the analysis report: ¥
a. Select “Display DCM Graph” Set the DCM analysis
b. Under “Set Direction of Travel,” set the “Side of Road” to s :nnr;?;;fvehide
“Increasing” to evaluate the highway in the direction of » Desired speed

+ Speed at start/end

increasing stations smious

[Se!ect DCM review items

rRunDCMAnaIySIS ]

5 Lesson 5
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Meraphs can be created
itely from the analysis
il Users can format the
fivia the “Create DCM
shic Output” dialog.

THSDM Tutorial

Inerustions

Degien of Furse (30
wow ¥ E % e %;Z%i" zssENE

&

@

Click on the “Show Graph” button. A “DCM Data Graph”
window should appear

d. Click on the maximize window icon in the upper right corner
e. Select “View>Toggle Legend” from the pull-down menu to
display the legend below the graph

Dasign Gonslstency Evalustion Surmmary
Projsct IHGDM Pike
Anatyste; Edsting HIDH Pil
Highweay: isdm piks
wrnms Diaction of Tesal # e e

WECHAER el it

Siautes

NOTE,ﬁpaﬂl pewlile diuas HOT aceaunl ferialergadtions.

e W v 3 s vt 441 s e

o R

vt g o i

T dh oo o a2 'f ik o s s
o e s Conen,

s
i o o g e AT v el o
I e f eeart e et -

L
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» Q5.1.1: What are the approximate locations of any red
“flags” on the speed praofile (indicating speed differentials
between adjacent design elements of >20 km/h)?

0 5.1.2: What are the approximate locations of any yellow
“flags”’ on the speed profile (indicating speed differentials
between adjacent design elements of > 10 km/h, <=20km/h)?

Locations of
Red Flags
(Station)

Locations of
Yellow Flags
(Station)

THSDM Tutorial

f. Close the graph by selecting “File” and “Close” from the pull-
down menu on the “DCM Data Graph” window

2. View/Interpret the DCM analysis report:
a. Click the “View Current Analysis Report” button

Lo

Jervolpin Eviti IHSOM_ Pice HEWENG 1690 8 Him
oy

efebhl

g B e B T
[HSDM Analysis Report

THSDM Version: 2.07(-040906, (Daily) on thsdm_test3
Date: Sep 13, 2004 2:2240 PM

Name: (HAWANG)

Organization: GDL

Telephone:

E-Mail:

Project: [ISDM Pike (THISDM Pike Evaluation)
Analysis: Existing [HSDM Pike (Existing IHSDM. Pike Evaluaton)
Highway Information: thsdm pike, chain: none (existing roadway design, file: thadm_pike)

Table of Contents

Analysis Report Index

1. Desyn Consistency Moduls

Desym Consistency Module Engineer's Manual|

Graph: Design Consistency Results (in the direction of increasing stations)
Graph Design Consistency Results (in the direction of decrea ing stations
Table: V85 Speed Profile Coordinates (in the directon of increasing, stations)
Table: V85 Sgeed Profile Coordinates (in the directon of decreasing stations

Table: Design Speed Assumption Checke (in the direction of increasing stations)

[Table of Contents]

B £ T Iiment DGR s e B T

b. Scroll through the Analysis Report (or click on link in the
Table of Contents) to find the Graph of Design Consistency
Results in the directions of increasing and decreasing
stations

Graphs are also in the analysis
report with a default format.

Lesson 5
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= Q 5.1.3: How do the speed profiles differ by direction of

travel?

198

How do the speed
profiles differ by
direction of
travel?

¢. Scroll down to the “Design Speed Assumption Check (in

the direction of decreasing stations)” table

= Q 5.1.4 Which two sections have the greatest differential

between the estimated operating speed (Vss) and the design
speed (Vaesign)? Where does this occur?

Greatest Station (From)
Differential
Between Vgs and
V design (km/ h)

Station (To)

d. Scroll down to the “Speed Differential of Adjacent Design
Elements Check (in the direction of increasing stations)”

table

»  (Q5.1.5: What is the greatest speed differential?

= (0 5.1.6: What is the start station of the curve with the

greatest speed differential?

Greatest Differential
Between Speed (Vss)
on Curve and

Preceding Element
(km/h)

Start Station of Curve

e. Close the Analysis Report
Exit THSDM

Lesson 5
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Lesson 5 Work Problem — Answer Key

Exercise 5.1

» (Q5.1.1: What are the approximate locations of any red
“flags” on the speed profile (indicating speed differentials
between adjacent design elements of >20 km/h)?

= Q5.1.2: What are the approximate locations of any yellow
“flags” on the speed profile (indicating speed differentials
between adjacent design elements of >10 km/h, <=20km/h)?

THSDM Tutorial

To access a pre-produced
copy of the analysis report
for Exercise 5.1:
1. Go to the
“Tutorial/Analysis_
Reports” folder under

your [HSDM directory.
2. Choose

“Exercise_5.1_DCM_

Report.htm”

Locations of
Red Flags
(Station)

1370

Locations of
Yellow Flags

(Station)

3020, 3200

* Q 5.1.3: How do the speed profiles differ by direction of

travel?

How do the speed | Possible answers include:

profiles differ by
direction of

travel?

- For compound curve beginning at sta. 1378:
red flag for increasing stations, green flag for
decreasing stations

- For curve beginning near sta. 3210: yellow
flag for increasing stations, red flag for
decreasing stations

»  Q 5.1.4 Which two sections have the greatest differential
between the estimated operating speed (Vgs) and the design
speed (Viesign)? Where does this occur?

Greatest Station (From) Station (To)
Differential
Between Vgs and
Vdesign (kn]/h)
20 4353.060 3398.454
20 1128.815 102.944

9
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= O 5.1.5: What is the greatest speed differential?
= Q5.1.6: What is the start station of the curve with the greatest

speed differential?

~

Greatest Differential
Between Speed (Vss)
on Curve and
Preceding Element
(km/h)

28.2

Start Station of Curve

1373.877

Go back to: Table of Contents

Go to the next lesson

200

Lesson 5



MaUwIN 2

HayALTIIAHANIIKAD 410 N1.2+665.000 4 37+544.350



o o M w BdN

. UYSunawnsa912s

U w.@.2545 ADT
U w.@.2546 ADT

= 8,431 AW
= 8,844 AW
Classification Anuatdudszinn Collector
Terrain fnuatduilszinn Level
aaNIezasluanis = 2.25 a3

AMNNINNVAIZDINWLAKID = 3.25 LUAT

nsagralnanis

39N 1 ANANTINTBINTVEN EJVL%QIYI’N

202

Start station End station Side of Widening (m) Begin Full width End Full width
Road staion station

4+685.322 4+872.278 left 0.3 4+720.370 4+837.230

6+889.219 7+051.718 right 0.3 6+918.760 7+022.090

7+051.718 7+190.486 right 0.5 7+078.887 7+160.881

8+146.345 8+282.140 left 0.75 8+169.745 8+258.120

8+563.625 8+727.816 left 0.3 8+591.510 8+699.280

9+761.725 9+950.866 right 0.75 9+788.270 9+924.360
12+210.533 12+388.184 left 0.75 12+241.857 12+356.857
13+356.230 13+629.640 left 0.3 13+382.940 13+602.040
16+763.340 17+140.100 left 0.3 16+792.300 17+111.150
17+157.677 17+309.707 right 0.3 17+188.840 17+289.480
17+309.707 17+434.990 right 0.3 17+332.350 17+432.714
18+289.892 18+463.241 left 0.3 18+325.480 18+427.580
18+590.007 19+076.458 right 0.3 18+624.040 19+046.420
19+143.552 19+340.065 right 0.3 19+173.480 19+310.140
19+612.723 19+891.573 left 0.3 19+643.880 19+860.410
20+664.228 20+809.679 right 0.75 20+708.767 20+770.520
21+175.225 21+533.487 left 0.3 21+204.156 21+474.390
22+468.760 22+590.010 right 0.3 22+480.000 22+570.000
27+227.363 27+408.272 left 0.3 27+259.270 27+377.360
29+457.141 29+626.429 left 0.3 29+491.520 29+592.050
31+670.890 31+830.850 left 0.3 31+694.890 31+806.850
33+780.750 33+945.250 right 0.3 33+804.780 33+921.250
35+079.170 35+358.350 right 0.3 35+105.636 35+319.759
35+838.934 35+991.423 right 0.75 35+858.500 35+948.000
35+991.423 36+190.188 left 0.3 36+009.960 36+150.290
36+419.376 36+649.204 left 0.5 36+448.510 36+620.070
36+691.156 36+857.850 right 0.5 36+727.660 36+829.730
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Element Start End Radius (m) Design Deflection Direction
Type Station Station Speed (km/h) Angle (degree)

Tangent 2+665.000 3+149.880 - - -
Simple Curve 3+149.880 3+368.210 2,804.790 60 Right
Tangent 3+368.210 3+672.820

Deflection 3+672.820 2° 13 00" Right
Tangent 3+672.820 3+825.000

Deflection 3+825.000 0° 33' 00" Right
Tangent 3+825.000 4+446.030

Deflection 4+446.030 0° 28' 00" Right
Tangent 4+446.030 4+720.370

Simple Curve 4+720.370 4+837.230 220.308 60 Left
Tangent 4+837.230 4+923.420

Simple Curve 4+923.420 5+054.460 716.198 60 Left
Tangent 5+054.460 5+234.480

Deflection 5+234.480 2° 05' 00" Left
Tangent 5+234.480 6+570.200

Simple Curve 6+570.200 6+775.020 716.198 60 Left
Tangent 6+775.020 6+918.760

Simple Curve 6+918.760 7+022.090 409.256 60 Right
Simple Curve 7+078.887 7+160.831 190.986 50 Right
Tangent 7+160.831 7+420.760

Simple Curve 7+420.760 7+569.090 2,864.790 60 Left
Tangent 7+569.090 7+702.360

Simple Curve 7+702.360 7+811.360 572.950 60 Left
Tangent 7+811.360 8+169.745

Simple Curve 8+169.745 8+258.120 143.240 40 Left
Tangent 8+258.120 8+591.510

Simple Curve 8+591.510 8+699.280 477.465 60 Left
Tangent 8+699.280 8+925.760

Simple Curve 8+925.760 9+146.590 2,864.790 60 Left
Tangent 9+146.590 9+788.270

Simple Curve 9+788.270 9+924.360 106.100 40 Right
Tangent 9+924.360 10+312.740

Simle Curve 10+312.740 10+554.820 716.198 60 Right
Tangent 10+554.820 10+696.350

Deflection 10+696.350 2° 47" 00" Left
Tangent 10+696.350 10+932.370

Simple Curve 10+932.370 11+115.510 636.620 60 Left
Tangent 11+115.510 11+209.960
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Element Start End Radius (m) Design Deflection Direction
Type Station Station Speed (km/h) Angle (degree)
Simple Curve 11+209.960 11+338.290 1,909.86 60 Right
Tangent 11+338.290 11+395.970
Simple Curve 11+395.970 11+523.740 954.930 60 Right
Tangent 11+523.740 11+587.670
Simple Curve 11+587.670 11+771.000 1,432.395 60 Right
Tangent 11+771.000 11+928.480
Simple Curve 11+928.480 12+039.810 572.958 60 Left
Tangent 12+039.810 12+241.857
Simple Curve 12+241.857 12+356.857 121.91 40 Left
Simple Curve 12+388.184 12+497.706 1,232.578 60 Left
Tangent 12+497.706 12+609.590
Simple Curve 12+609.590 12+759.920 1,145.916 60 Right
Tangent 12+759.920 13+382.940
Simple Curve 13+382.940 13+602.040 440.737 60 Left
Tangent 13+602.040 13+699.600
Simple Curve 13+699.600 13+817.930 876.922 60 Right
Tangent 13+817.930 14+106.831
Simple Curve 14+106.831 14+184.550 716.197 60 Right
Tangent 14+184.550 14+446.140
Deflection 14+446.140 10 47’ 00” Right
Tangent 14+446.140 14+707.340
Simple Curve 14+707.340 14+947.340 1,145.916 60 Right
Tangent 14+947.340 15+106.580
Simple Curve 15+106.580 15+207.460 381.972 30 Left
Tangent 15+207.460 15+238.450
Simple Curve 15+238.450 15+346.150 716.198 40 Right
Tangent 15+346.150 15+400.820
Simple Curve 15+400.820 15+518.200 818.511 40 Left
Tangent 15+518.200 15+626.910
Simple Curve 15+626.910 15+842.460 1,909.800 60 Right
Tangent 15+842.460 15+991.230
Simple Curve 15+991.230 16+153.730 2,864.790 60 Right
Tangent 16+153.730 16+792.300
Simple Curve 16+792.300 17+111.150 358.099 60 Left
Tangent 17+111.150 17+188.840
Simple Curve 17+188.840 17+289.480 440.737 60 Right
Simple Curve 17+332.350 17+432.714 337.034 60 Right
Simple Curve 17+434.990 17+562.280 751.904 60 Left
Tangent 17+562.280 17+673.430
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Element Start End Radius (m) Design Deflection Direction
Type Station Station Speed (km/h) Angle (degree)
Simple Curve 17+673.430 17+812.760 1,145.916 60 Right
Tangent 17+812.760 18+141.980
Simple Curve 18+141.980 18+195.180 1,145.916 60 Right
Tangent 18+195.180 18+325.480
Simple Curve 18+325.480 18+427.580 318.310 60 Left
Tangent 18+427.580 18+624.040
Simple Curve 18+624.040 19+046.420 477.465 60 Right
Tangent 19+046.420 19+173.480
Simple Curve 19+173.480 19+310.140 337.034 60 Right
Tangent 19+310.140 19+643.880
Simple Curve 19+643.880 19+860.410 440.737 60 Left
Tangent 19+860.410 20+194.440
Deflection 20+194.440 1° 20" 00" Left
Tangent 20+194.440 20+708.767
Simple Curve 20+708.767 20+770.520 92.413 40 Right
Tangent 20+770.520 21+204.156
Simple Curve 21+204.156 21+474.390 440.740 60 Left
Tangent 21+474.390 21+949.150
Simple Curve 21+949.150 22+046.650 1,432.395 60 Left
Tangent 22+046.650 22+217.800
Simple Curve 22+217.800 22+392.800 2,864.790 60 Right
Tangent 22+392.800 22+468.760
Simple Curve 22+468.760 22+590.010 477.465 60 Right
Tangent 22+590.010 23+190.160
Deflection 23+190.160 1° 24' 00" Left
Tangent 23+190.160 23+437.970
Simple Curve 23+437.970 23+621.300 2,864.790 60 Left
Tangent 23+621.300 23+945.050
Simple Curve 23+945.050 24+062.130 716.198 60 Right
Tangent 24+062.130 24+655.450
Deflection 24+655.450 00 41' 00" Left
Tangent 24+655.450 25+333.100
Simple Curve 25+333.100 25+528.450 954.930 60 Left
Tangent 25+528.450 26+252.750
Deflection 26+252.750 10 25' 00" Left
Tangent 26+252.750 26+746.000
Simple Curve 26+746.000 26+868.160 572.958 60 Left
Tangent 26+868.160 27+259.270
Simple Curve 27+259.270 27+377.360 409.260 60 Left
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Element Start End Radius (m) Design Deflection Direction
Type Station Station Speed (km/h) Angle (degree)
Tangent 27+377.360 28+058.916
Simple Curve 28+058.916 28+170.820 818.511 60 Right
Tangent 28+170.820 28+452.410
Simple Curve 28+452.410 28+608.240 2,864.790 60 Right
Tangent 28+608.240 29+052.960
Simple Curve 29+052.960 29+233.460 572.958 60 Right
Tangent 29+233.460 29+491.520
Simple Curve 29+491.520 29+592.050 229.183 60 Left
Tangent 29+592.050 29+877.787
Simple Curve 29+877.787 30+088.453 954.930 60 Right
Tangent 30+088.453 30+362.560
Simple Curve 30+362.560 30+519.220 716.198 60 Right
Tangent 30+519.220 30+889.600
Simple Curve 30+889.600 31+061.540 954.930 60 Right
Tangent 31+061.540 31+694.890
Simple Curve 31+694.890 31+806.850 337.034 60 Left
Tangent 31+806.850 32+137.540
Deflection 32+137.540 10 00' 00" Right
Tangent 32+137.540 32+581.890
Simple Curve 32+581.890 32+713.000 954.930 60 Left
Tangent 32+713.000 32+869.740
Simple Curve 32+869.740 33+143.070 954.930 60 Left
Tangent 33+143.070 33+225.610
Simple Curve 33+225.610 33+352.770 572.958 60 Left
Tangent 33+352.770 33+804.780
Simple Curve 33+804.780 33+921.250 337.034 60 Right
Tangent 33+921.250 34+156.420
Deflection 34+156.420 1° 24' 00" Left
Tangent 34+156.420 34+554.268
Simple Curve 34+554.268 34+935.120 2,291.831 60 Left
Tangent 34+935.120 35+105.636
Simple Curve 35+105.636 35+319.759 301.556 60 Right
Tangent 35+319.759 35+619.259
Simple Curve 35+619.259 35+836.759 572.958 60 Left
Simple Curve 35+858.500 35+948.000 163.702 60 Right
Simple Curve 36+009.960 36+150.290 337.034 60 Left
Tangent 36+150.290 36+253.210
Simple Curve 36+253.210 36+372.370 572.958 60 Left
Tangent 36+372.370 36+448.510
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Element Start End Radius (m) Design Deflection Direction
Type Station Station Speed (km/h) Angle (degree)

Simple Curve 36+448.510 36+620.070 190.986 40 Left

Tangent 36+620.070 36+727.660

Simple Curve 36+727.660 36+829.730 173.624 50 Right

Tangent 38+829.730 37+050.000

Deflection 37+050.000 OO 52' 00" Left

Tangent 37+050.000 37+544.350

8. BRI (Cross Section)

TR 3 midanun

Station Side of Road Cross Slope (%) Station Side of Road Cross Slope (%)

2+665.000 both -25 7+140.760 left 52
3+149.880 both -2.5 7+140.760 right -5.2
3+368.210 both -2.5 7+190.486 both -2.5
4+685.322 both -2.5 7+420.760 both -25
4+739.241 left -5.5 7+569.090 both -2.5
4+739.241 right 5.5 7+670.180 both -2.5
4+818.360 left -5.5 7+710.399 left -2.5
4+818.360 right 55 7+710.399 right 25
4+872.278 both -2.5 7+803.011 left -2.5
4+891.249 both -2.5 7+803.011 right 2.5
4+931.464 left -2.5 7+843.530 both -2.5
4+931.464 right 25 8+146.345 both -2.5
5+046.413 left -2.5 8+175.595 left -3.2
5+046.413 right 25 8+175.595 right 3.2
5+086.632 both -2.5 8+252.270 left -3.2
6+538.025 both -25 8+252.270 right 3.2
6+578.244 left -2.5 8+282.140 both -2.5
6+578.244 right 25 8+563.625 both -2.5
6+767.776 left -25 8+606.516 left -3
6+767.776 right 25 8+606.516 right 3
6+807.995 both -25 8+684.283 left -3
6+889.219 both -2.5 8+684.283 right 3
6+934.712 left 3.5 8+727.816 both -2.5
6+934.712 right -3.5 8+925.760 both -2.5
7+006.136 left 3.5 9+146.590 both -25
7+006.136 right -3.5 9+761.725 both -2.5
7+098.821 left 52 9+809.980 left 6
7+098.821 right -5.2 9+809.980 right -6
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Station Side of Road Cross Slope (%) Station Side of Road Cross Slope (%)
9+893.157 left 6 12+617.630 right -25
9+893.157 right -6 12+751.820 left 25
9+950.866 both -2.5 12+751.820 right -25
10+280.557 both -2.5 12+792.100 both -2.5
10+323.458 left 25 13+356.230 both -2.5
10+323.458 right -25 13+400.740 left -3.3
10+544.091 left 25 13+400.740 right 3.3
10+544.091 right -25 13+585.130 left -3.3
10+568.992 both -2.5 13+585.130 right 3.3
10+902.205 both -25 13+629.640 both -2.5
10+942.424 left -25 13+670.100 both -25
10+942.424 right 25 13+710.320 left 25
11+105.455 left -25 13+710.320 right -25
11+105.455 right 25 13+807.230 left 25
11+145.674 both -25 13+807.230 right -2.5
11+209.960 both -25 13+847.440 both -2.5
11+338.290 both -2.5 14+074.660 both -2.5
11+365.801 both -25 14+144.880 left 25
11+406.020 left 2.5 14+144.880 right -2.5
11+406.020 right -2.5 14+176.810 left 25
11+513.419 left 2.5 14+176.810 right -2.5
11+513.419 right -2.5 14+216.730 both -2.5
11+553.628 both -25 14+675.135 both -2.5
11+587.670 both -2.5 14+715.354 left 25
11+771.000 both -2.5 14+715.354 right -2.5
11+898.313 both -2.5 14+939.296 left 25
11+938.532 left -25 14+939.296 right -25
11+938.532 right 2.5 14+979.515 both -2.5
12+029.755 left -25 15+106.580 both -25
12+029.755 right 2.5 15+207.460 both -2.5
12+069.970 both -25 15+238.450 both -2.5
12+210.530 both -2.5 15+346.150 both -2.5
12+255.283 left -5.2 15+400.820 both -25
12+255.283 right 52 15+518.200 both -25
12+343.431 left -5.2 15+626.910 both -25
12+343.431 right 5.2 15+842.460 both -2.5
12+388.184 both -2.5 15+991.230 both -2.5
12+497.706 both -25 16+153.730 both -2.5
12+577.410 both -2.5 16+763.340 both -2.5
12+617.630 left 25 16+811.610 left -4
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Station Side of Road Cross Slope (%) Station Side of Road Cross Slope (%)
16+811.610 right 4 19+033.557 right -3
17+091.840 left -4 19+076.458 both -2.5
17+091.840 right 4 19+143.552 both -25
17+140.100 both -2.5 19+193.424 left 4.3
17+157.677 both -25 19+193.424 right -4.3
17+202.193 left 3.3 19+290.193 left 43
17+202.193 right -3.3 19+290.193 right -4.3
17+267.226 left 3.3 19+340.065 both -25
17+267.226 right -3.3 19+612.723 both -2.5
17+357.014 left 4.2 19+657.232 left -3.3
17+357.014 right 4.2 19+657.232 right 3.3
17+410.325 left 4.2 19+847.000 left -3.3
17+410.325 right 4.2 19+847.000 right 3.3
17+455.013 left -25 19+891.573 both -25
17+455.013 right 2.5 20+664.228 both -2.5
17+552.213 left -25 20+716.440 left 6.9
17+552.213 right 25 20+716.440 right -6.9
17+592.450 both -2.5 20+756.570 left 6.9
17+641.252 both -2.5 20+756.570 right -6.9
17+681.471 left 25 20+809.679 both -2.5
17+681.471 right -2.5 21+175.225 both -2.5
17+804.715 left 25 21+219.734 left -3.3
17+804.715 right -2.5 21+219.734 right 3.3
17+844.935 both -25 21+487.674 left -3.3
18+109.805 both -2.5 21+487.674 right 3.3
18+150.024 left 25 21+533.487 both -2.5
18+150.024 right -25 21+949.150 both -25
18+240.264 left 25 22+046.650 both -2.5
18+240.264 right -25 22+217.800 both -25
18+280.483 both -2.5 22+392.800 both -2.5
18+289.892 both -25 22+468.760 left 3
18+340.836 left 4.5 22+468.760 right -3
18+340.836 right 45 22+590.010 left 3
18+412.297 left -4.5 22+590.010 right -3
18+412.297 right 45 23+190.160 both -2.5
18+463.241 both -25 23+437.970 both -2.5
18+590.007 both -2.5 23+621.300 both -2.5
18+632.908 left 3 23+912.875 both -2.5
18+632.908 right -3 23+953.094 left 25
19+033.557 left 3 23+953.094 right -2.5
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Station Side of Road Cross Slope (%) Station Side of Road Cross Slope (%)
24+054.086 left 25 29+626.429 both -25
24+054.086 right -2.5 29+845.612 both -2.5
24+094.305 both -2.5 29+885.831 left 25
25+302.711 both -25 29+885.831 right -25
25+342.930 left -2.5 30+081.409 left 25
25+342.930 right 25 30+081.409 right -2.5
25+524.342 left -25 30+121.628 both -25
25+524.342 right 25 30+343.060 both -25
25+564.561 both -2.5 30+382.060 left 25
26+713.825 both -25 30+382.060 right -25
26+754.044 left -2.5 30+499.720 left 2.5
26+754.044 right 25 30+499.720 right -25
26+860.116 left -25 30+538.720 both -25
26+860.116 right 25 30+870.100 both -25
26+900.335 both -2.5 30+909.100 left 25
27+227.363 both -25 30+909.100 right -25
27+272.945 left -3.5 31+042.040 left 2.5
27+272.945 right 35 31+042.040 right -25
27+362.685 left -35 31+081.040 both -25
27+362.685 right 35 31+670.890 both -2.5
27+408.272 both -2.5 31+718.890 left -4.3
28+026.741 both -2.5 31+718.890 right 43
28+086.960 left 25 31+782.850 left -4.3
28+086.960 right -2.5 31+782.850 right 43
28+162.776 left 25 31+830.850 both -25
28+162.776 right -2.5 32+562.390 both -2.5
28+202.995 both -25 32+601.390 left -25
28+452.410 both -2.5 32+601.390 right 25
28+608.240 both -25 32+693.500 left -25
29+020.785 both -2.5 32+693.500 right 25
29+061.004 left 25 32+732.500 both -25
29+061.004 right -2.5 32+850.240 both -2.5
29+225.416 left 25 32+889.240 left -25
29+225.416 right -2.5 32+889.240 right 2.5
29+265.535 both -2.5 33+123.570 left -25
29+457.141 both -2.5 33+123.570 right 2.5
29+510.032 left -5.3 33+162.570 both -25
29+510.032 right 5.3 33+206.110 both -25
29+573.538 left -5.3 33+245.110 left -25
29+573.538 right 5.3 33+245.110 right 2.5
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Station Side of Road Cross Slope (%) Station Side of Road Cross Slope (%)
33+333.270 left -25 35+933.199 right -8.8
33+333.270 right 25 36+019.874 left 4.3
33+372.270 both -25 36+019.874 right 43
33+780.780 both -25 36+140.316 left -4.3
33+828.780 left 43 36+140.316 right 43
33+828.780 right -4.3 36+190.188 both -25
33+897.250 left 43 36+221.075 both -2.5
33+897.250 right -4.3 36+261.294 left -2.5
33+945.250 both -2.5 36+261.294 right 25
34+554.268 both -25 36+364.286 left -25
34+935.120 both -2.5 36+364.286 right 25
35+079.170 both -25 36+404.505 both -2.5
35+128.170 left 47 36+419.376 both -25
35+128.170 right -4.7 36+455.793 left -3.3
35+309.350 left 4.7 36+455.793 right 3.3
35+309.350 right -4.7 36+612.787 left -3.3
35+358.350 both -2.5 36+612.787 right 3.3
35+587.084 both -25 36+649.204 both -2.5
35+627.305 left -25 36+691.156 both -25
35+627.305 right 25 36+736.787 left 5.8
35+798.715 left -25 36+736.787 right -5.8
35+798.715 right 25 36+820.604 left 5.8
35+873.301 left 8.8 36+820.604 right -5.8
35+873.301 right -8.8 36+857.850 both -2.5
35+933.199 left 8.8 37+544.350 both -25

9. LLWINIAY (Vertical Alignment)

@131971 4 32AU (Elevation)

Station

Elevation (m)

2+800.000

3.00
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@1371971 5 Vertical Point of Intersection (VPI)

VPI Station Back Grade (%) Back Length (m) Forward Grade (%) Forward Length (m)
2+800.000 0.75 75 0 75
8+400.000 0.11 50 -0.32 50
8+650.000 -0.32 50 0.12 50
8+975.000 0.12 50 -0.04 50
9+950.000 -0.04 50 0.18 50
10+225.000 0.18 50 0.37 50
10+400.000 0.37 50 -0.03 50
14+950.000 -0.03 50 0.44 50
15+050.000 0.44 50 -0.01 50
18+450.000 0.07 50 -0.06 50
21+825.000 -0.05 100 0.17 100
22+125.000 0.17 100 0.03 100
24+400.000 0.04 100 0.15 100
24+650.000 0.15 100 -0.08 100
24+900.000 -0.08 100 0.04 100
27+550.000 -0.04 50 0.17 50

A1319N 6 ANNAIATH (Tangent Grade)

Start Stion End Station Tangent Grade (%) Start Stion End Station Tangent Grade (%)
2+875.000 4+850.000 0 25+678.000 | 25+800.000 -0.1
4+850.000 5+375.000 0.15 25+800.000 | 26+225.000 0
5+375.000 5+750.000 0 26+225.000 | 27+025.000 -0.02
5+750.000 6+250.000 0.08 28+150.000 | 28+850.000 0
6+250.000 7+125.000 0.06 28+850.000 | 29+000.000 -0.13
7+125.000 7+525.000 0 29+000.000 | 29+025.000 -3.52
7+525.000 8+350.000 0.11 29+025.000 | 29+050.000 0.16
11+100.000 11+875.000 0 29+050.000 | 29+075.000 0
11+875.000 12+575.000 0.02 29+075.000 | 29+100.000 -0.12
12+575.000 13+375.000 0.12 29+100.000 | 29+125.000 0.04
13+375.000 14+200.000 0 29+125.000 | 29+150.000 0.12
15+525.000 16+200.000 0 29+150.000 | 29+175.000 0.04
16+200.000 16+475.000 0.22 29+175.000 | 29+200.000 -0.24
16+475.000 17+775.000 0.05 29+200.000 | 29+225.000 -0.12
19+225.000 | 20+325.000 0.14 29+225.000 | 29+250.000 -0.24
20+325.000 | 21+096.500 0.11 29+250.000 | 29+275.000 0
21+096.500 | 21+142.100 0 29+275.000 | 29+300.000 0.04
23+025.000 | 24+100.000 0.02 29+300.000 | 29+325.000 0.12
25+450.000 | 25+636.000 0.23 29+325.000 | 29+350.000 0.12
25+636.000 | 25+678.000 0 29+350.000 | 29+375.000 -0.16




aN3197 6 (7i0)

Start Stion End Station Tangent Grade (%) Start Stion End Station Tangent Grade (%)
29+375.000 | 29+400.000 -0.28 30+375.000 | 30+400.000 0.2
29+400.000 | 29+425.000 0.08 30+400.000 | 30+425.000 -0.36
29+425.000 | 29+450.000 0.04 30+425.000 | 30+450.000 0.44
29+450.000 | 29+475.000 -0.2 30+450.000 | 30+475.000 -0.16
29+475.000 | 29+500.000 -04 30+475.000 | 30+500.000 0.16
29+500.000 | 29+525.000 0.24 30+500.000 | 30+525.000 -0.28
29+525.000 | 29+550.000 1.32 30+525.000 | 30+550.000 -0.44
29+550.000 | 29+575.000 1.84 30+550.000 | 30+575.000 -0.48
29+575.000 | 29+600.000 2.04 30+575.000 | 30+600.000 -0.08
29+600.000 | 29+625.000 14 30+600.000 | 30+625.000 0
29+625.000 | 29+650.000 1.28 30+625.000 | 30+650.000 -0.24
29+650.000 | 29+675.000 0.96 30+650.000 | 30+675.000 -0.24
29+675.000 | 29+700.000 0.72 30+675.000 | 30+700.000 -0.12
29+700.000 | 29+725.000 0.4 30+700.000 | 30+725.000 0.16
29+725.000 | 29+750.000 0.04 30+725.000 | 30+750.000 0.24
29+750.000 | 29+775.000 0.16 30+750.000 | 30+775.000 1.44
29+775.000 | 29+800.000 0.16 30+775.000 | 30+800.000 14
29+800.000 | 29+825.000 -0.28 30+800.000 | 30+825.000 212
29+825.000 | 29+850.000 0.08 30+825.000 | 30+850.000 1.92
29+850.000 | 29+875.000 0.4 30+850.000 | 30+875.000 1.84
29+875.000 | 29+900.000 -0.36 30+875.000 | 30+900.000 -0.16
29+900.000 | 29+925.000 0.36 30+900.000 | 30+925.000 4
29+925.000 | 29+950.000 -0.16 30+925.000 | 30+950.000 1.36
29+950.000 | 29+975.000 0.08 30+950.000 | 30+975.000 0.8
29+975.000 | 30+000.000 0.16 30+975.000 | 31+000.000 0.04
30+000.000 | 30+025.000 0.08 31+000.000 | 31+025.000 -0.04
30+025.000 | 30+050.000 0 31+025.000 | 31+050.000 -0.72
30+050.000 | 30+075.000 0.08 31+050.000 | 31+075.000 -1.12
30+075.000 | 30+100.000 0 31+075.000 | 31+100.000 -1.8
30+100.000 | 30+125.000 -0.04 31+100.000 | 31+125.000 -2.08
30+125.000 | 30+150.000 0.04 31+125.000 | 31+150.000 -2.16
30+150.000 | 30+175.000 0.72 31+150.000 | 31+175.000 -2.04
30+175.000 | 30+200.000 0.56 31+175.000 | 31+200.000 -1.4
30+200.000 | 30+225.000 0.44 31+200.000 | 31+225.000 -0.8
30+225.000 | 30+250.000 0.36 31+225.000 | 31+250.000 -0.52
30+250.000 | 30+275.000 0.32 31+250.000 | 31+275.000 0.32
30+275.000 | 30+300.000 0.44 31+275.000 | 31+300.000 0.52
30+300.000 | 30+325.000 -0.04 31+300.000 | 31+325.000 1.2
30+325.000 | 30+350.000 0.08 31+325.000 | 31+350.000 1.76
30+350.000 | 30+375.000 -0.28 31+350.000 | 31+375.000 -1.08
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Start Stion End Station Tangent Grade (%) Start Stion End Station Tangent Grade (%)
31+375.000 | 31+400.000 6.56 32+375.000 | 32+400.000 -0.08
31+400.000 | 31+425.000 1.2 32+400.000 | 32+425.000 0
31+425.000 | 31+450.000 -0.64 32+425.000 | 32+450.000 0
31+450.000 | 31+475.000 -2.36 32+450.000 | 32+475.000 0.2
31+475.000 | 31+500.000 -3.36 32+475.000 | 32+500.000 -0.12
31+500.000 | 31+525.000 -2.48 32+500.000 | 32+525.000 0.12
31+525.000 | 31+550.000 -1.84 32+525.000 | 32+550.000 0.04
31+550.000 | 31+575.000 -0.76 32+550.000 | 32+575.000 -0.04
31+575.000 | 31+600.000 -0.24 32+575.000 | 32+600.000 0.12
31+600.000 | 31+625.000 0.16 32+600.000 | 32+625.000 0.04
31+625.000 | 31+650.000 0.08 32+625.000 | 32+650.000 -0.04
31+650.000 | 31+675.000 0.16 32+650.000 | 32+675.000 0.04
31+675.000 | 31+700.000 0.08 32+675.000 | 32+700.000 0.16
31+700.000 | 31+725.000 -0.16 32+700.000 | 32+725.000 -0.08
31+725.000 | 31+750.000 0 32+725.000 | 32+750.000 -0.08
31+750.000 | 31+775.000 0.16 32+750.000 | 32+775.000 0.08
31+775.000 | 31+800.000 0.08 32+775.000 | 32+800.000 0
31+800.000 | 31+825.000 -0.44 32+800.000 | 32+825.000 -0.08
31+825.000 | 31+850.000 -0.68 32+825.000 | 32+850.000 0.2
31+850.000 | 31+875.000 -1.16 32+850.000 | 32+875.000 0.04
31+875.000 | 31+900.000 -0.24 32+875.000 | 32+900.000 0.04
31+900.000 | 31+925.000 0 32+900.000 | 32+925.000 0.04
31+925.000 | 31+950.000 0 32+925.000 | 32+950.000 -0.36
31+950.000 | 31+975.000 0.08 32+950.000 | 32+975.000 0.16
31+975.000 | 32+000.000 0 32+975.000 | 33+000.000 -0.04
32+000.000 | 32+025.000 -0.04 33+000.000 | 33+025.000 0.04
32+025.000 | 32+050.000 0.04 33+025.000 | 33+050.000 0.08
32+050.000 | 32+075.000 -0.04 33+050.000 | 33+075.000 -0.04
32+075.000 | 32+100.000 0.04 33+075.000 | 33+100.000 0.12
32+100.000 | 32+125.000 0.76 33+100.000 | 33+125.000 0.08
32+125.000 | 32+150.000 1.04 33+125.000 | 33+150.000 -0.04
32+150.000 | 32+175.000 0.68 33+150.000 | 33+175.000 -0.04
32+175.000 | 32+200.000 0.2 33+175.000 | 33+200.000 0.24
32+200.000 | 32+225.000 -0.04 33+200.000 | 33+225.000 -0.2
32+225.000 | 32+250.000 0 33+225.000 | 33+250.000 0.08
32+250.000 | 32+275.000 0.16 33+250.000 | 33+275.000 -0.16
32+275.000 | 32+300.000 0.08 33+275.000 | 33+300.000 0.12
32+300.000 | 32+325.000 0 33+300.000 | 33+325.000 -0.8
32+325.000 | 32+350.000 -0.8 33+325.000 | 33+350.000 0.96
32+350.000 | 32+375.000 0.84 33+350.000 | 33+375.000 -0.16

214



aN3197 6 (7i0)

Start Stion End Station Tangent Grade (%) Start Stion End Station Tangent Grade (%)
33+375.000 | 33+400.000 0.16 34+375.000 | 34+400.000 0.12
33+400.000 | 33+425.000 -0.04 34+400.000 | 34+425.000 0.12
33+425.000 | 33+450.000 0 34+425.000 | 34+450.000 0
33+450.000 | 33+475.000 0.08 34+450.000 | 34+475.000 0
33+475.000 | 33+500.000 -0.04 34+475.000 | 34+500.000 0
33+500.000 | 33+525.000 0.12 34+500.000 | 34+525.000 0.12
33+525.000 | 33+550.000 -0.04 34+525.000 | 34+550.000 -0.08
33+550.000 | 33+575.000 0.08 34+550.000 | 34+575.000 0.08
33+575.000 | 33+600.000 0.08 34+575.000 | 34+600.000 0.12
33+600.000 | 33+625.000 -0.08 34+600.000 | 34+625.000 0.04
33+625.000 | 33+650.000 0.08 34+625.000 | 34+650.000 0.04
33+650.000 | 33+675.000 -0.04 34+650.000 | 34+675.000 -0.04
33+675.000 | 33+700.000 0.04 34+675.000 | 34+700.000 0
33+700.000 | 33+725.000 0.12 34+700.000 | 34+725.000 -0.16
33+725.000 | 33+750.000 0.72 34+725.000 | 34+750.000 0.24
33+750.000 | 33+775.000 1.16 34+750.000 | 34+775.000 0.04
33+775.000 | 33+800.000 1.72 34+775.000 | 34+800.000 0.28
33+800.000 | 33+825.000 1.8 34+800.000 | 34+825.000 -0.24
33+825.000 | 33+850.000 1.76 34+825.000 | 34+850.000 -0.2
33+850.000 | 33+875.000 1 34+850.000 | 34+875.000 0.12
33+875.000 | 33+900.000 0.44 34+875.000 | 34+900.000 0.04
33+900.000 | 33+925.000 -0.76 34+900.000 | 34+925.000 0.04
33+925.000 | 33+950.000 -1.2 34+925.000 | 34+950.000 0.04
33+950.000 | 33+975.000 -2.28 34+950.000 | 34+975.000 -0.04
33+975.000 | 34+000.000 -1.64 34+975.000 | 35+000.000 0.04
34+000.000 | 34+025.000 -1.28 35+000.000 | 35+025.000 -0.08
34+025.000 | 34+050.000 -0.76 35+025.000 | 35+050.000 0.08
34+050.000 | 34+075.000 -0.44 35+050.000 | 35+075.000 0.12
34+075.000 | 34+100.000 0.28 35+075.000 | 35+100.000 -0.04
34+100.000 | 34+125.000 -0.32 35+100.000 | 35+125.000 0.04
34+125.000 | 34+150.000 -0.04 35+125.000 | 35+150.000 -0.6
34+150.000 | 34+175.000 0.08 35+150.000 | 35+175.000 0.32
34+175.000 | 34+200.000 -0.08 35+175.000 | 35+200.000 0.12
34+200.000 | 34+225.000 0.16 35+200.000 | 35+225.000 0.16
34+225.000 | 34+250.000 -0.08 35+225.000 | 35+250.000 -0.08
34+250.000 | 34+275.000 0.08 35+250.000 | 35+275.000 0.32
34+275.000 | 34+300.000 -0.12 35+275.000 | 35+300.000 0.4
34+300.000 | 34+325.000 0.04 35+300.000 | 35+325.000 -0.16
34+325.000 | 34+350.000 -0.08 35+325.000 | 35+350.000 0.04
34+350.000 | 34+375.000 0.08 35+350.000 | 35+375.000 -0.04
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Start Stion End Station Tangent Grade (%) Start Stion End Station Tangent Grade (%)
35+375.000 | 35+400.000 -0.2 36+375.000 | 36+400.000 -0.28
35+400.000 | 35+425.000 0.04 36+400.000 | 36+425.000 -0.32
35+425.000 | 35+450.000 0.04 36+425.000 | 36+450.000 -0.32
35+450.000 | 35+475.000 0.04 36+450.000 | 36+475.000 -0.32
35+475.000 | 35+500.000 0 36+475.000 | 36+500.000 -0.28
35+500.000 | 35+525.000 0.04 36+500.000 | 36+525.000 -0.32
35+525.000 | 35+550.000 0.04 36+525.000 | 36+550.000 -0.32
35+550.000 | 35+575.000 0.04 36+550.000 | 36+575.000 -0.28
35+575.000 | 35+600.000 0.04 36+575.000 | 36+600.000 -0.32
35+600.000 | 35+625.000 0 36+600.000 | 36+625.000 -0.32
35+625.000 | 35+650.000 0.04 36+625.000 | 36+650.000 -0.28
35+650.000 | 35+675.000 0.04 36+650.000 | 36+675.000 -0.32
35+675.000 | 35+700.000 0.04 36+675.000 | 36+700.000 -0.32
35+700.000 | 35+725.000 0.04 36+700.000 | 36+725.000 -0.28
35+725.000 | 35+750.000 0.04 36+725.000 | 36+750.000 -0.32
35+750.000 | 35+775.000 0 36+750.000 | 36+775.000 -0.32
35+775.000 | 35+800.000 0.04 36+775.000 | 36+800.000 -0.28
35+800.000 | 35+825.000 0.08 36+800.000 | 36+825.000 -0.44
35+825.000 | 35+850.000 -0.04 36+825.000 | 36+850.000 -0.2
35+850.000 | 35+875.000 0.08 36+850.000 | 36+875.000 -0.08
35+875.000 | 35+900.000 0.04 36+875.000 | 36+903.550 0
35+900.000 | 35+925.000 0 36+903.550 | 36+925.000 -2.68
35+925.000 | 35+950.000 0.04 36+925.000 | 36+950.000 -0.08
35+950.000 | 35+975.000 0.04 36+950.000 | 36+975.000 0.04
35+975.000 | 36+000.000 0.04 36+975.000 | 37+000.000 0
36+000.000 | 36+025.000 0.32 37+000.000 | 37+025.000 1
36+025.000 | 36+050.000 0.28 37+025.000 | 37+050.000 0.2
36+050.000 | 36+075.000 0.32 37+050.000 | 37+075.000 0.2
36+075.000 | 36+100.000 0.28 37+075.000 | 37+100.000 0.2
36+100.000 | 36+125.000 0.32 37+100.000 | 37+125.000 -0.08
36+125.000 | 36+150.000 0.28 37+125.000 | 37+150.000 -0.12
36+150.000 | 36+175.000 0.32 37+150.000 | 37+175.000 0.16
36+175.000 | 36+200.000 0.28 37+175.000 | 37+200.000 -0.04
36+200.000 | 36+225.000 0.32 37+200.000 | 37+225.000 0.04
36+225.000 | 36+250.000 0.28 37+225.000 | 37+250.000 0.04
36+250.000 | 36+275.000 0.32 37+250.000 | 37+275.000 -0.28
36+275.000 | 36+300.000 0.28 37+275.000 | 37+300.000 -0.08
36+300.000 | 36+325.000 -0.32 37+300.000 | 37+325.000 -0.16
36+325.000 | 36+350.000 -0.28 37+325.000 | 37+350.000 0.68
36+350.000 | 36+375.000 -0.32 37+350.000 | 37+374.350 0

216



aN3197 6 (7i0)
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Start Stion End Station Tangent Grade (%) Start Stion End Station Tangent Grade (%)
37+374.350 37+399.350 -0.72 37+474.350 37+499.350 0.16
37+399.350 37+424.350 0.04 37+499.350 37+524.350 -0.36
37+424.350 37+449.350 -0.08 37+524.350 37+544.350 -0.5
37+449.350 37+474.350 -0.16
\ Y] (=3 .
10. Jzaz@IUALINIINAILKY (Obstruction)
A a @ = .
AN 7 ITACRIUALINITNDILAY (Obstructlon offset)
Start Station End Station Side of Road Centerline Offset (m)
2+665.000 37+544.350 both 6

11. AANIIVDIAENH (Bridge Elements)

ANTNN 8 ANANTINVBIREWIY

Start Station End Station Bridge Width (m)
21+119.300 21+164.900 10.00
25+657.000 25+699.000 10.00
31+997.000 32+039.200 10.00
36+880.850 36+926.850 10.00
37+363.850 37+384.850 10.00
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m‘s"l\‘]‘ﬁ 1 ANUNINVDIN Wb (Traveled Way Width Policy Check)

Stations Traveled Way Width and Widening
Road Policy Comment Attributes
Start End (width+widening (width+widening)

4+720.370 | 4+837.230 6.50 + 0.30 7.20 + 0.00 Road value varies from Speed: 60 (km/h); class: collector; terrain: level; DHV: 1,061
controlling criteria (v/hr); ADT: 8,844 (v/day); radius: 220.31 (m); TWW:7.20 (m)

7+078.887 | 7+160.831 6.50 + 0.50 7.20 + 0.00 Road value varies from Speed: 50 (km/h); class: collector; terrain: level; DHV: 1,061
controlling criteria (v/hr); ADT: 8,844 (v/day); radius: 190.99 (m); TWW:7.20 (m)

8+169.745 | 8+258.120 6.50 + 0.75 7.20 + 0.00 Road value is within controlling |Speed: 40 (km/h); class: collector; terrain: level; DHV: 1,061
criteria (v/hr); ADT: 8,844 (v/day); radius: 143.24 (m); TWW:7.20 (m)

9+788.270 | 9+924.360 6.50 + 0.75 7.20 + 0.00 Road value is within controlling |Speed: 40 (km/h); class: collector; terrain: level; DHV: 1,061
criteria (v/hr); ADT: 8,844 (v/day); radius: 106.10 (m); TWW:7.20 (m)

12+241.857|12+356.857 6.50 + 0.75 7.20 + 0.00 Road value is within controlling |Speed: 40 (km/h); class: collector; terrain: level; DHV: 1,061
criteria (v/hr); ADT: 8,844 (v/day); radius: 121.91 (m); TWW:7.20 (m)

16+792.300(17+111.150| 6.50 + 0.30 7.20 + 0.00 Road value varies from Speed: 60 (km/h); class: collector; terrain: level; DHV: 1,061
controlling criteria (v/hr); ADT: 8,844 (v/day); radius: 358.10 (m); TWW:7.20 (m)

20+708.767|20+770.520 6.50 + 0.75 7.20 + 0.60 Road value varies from Speed: 50 (km/h); class: collector; terrain: level; DHV: 1,061
controlling criteria (v/hr); ADT: 8,844 (v/day); radius: 92.41 (m); TWW:7.20 (m)

29+491.520(29+592.050 6.50 + 0.30 7.20 + 0.00 Road value varies from Speed: 60 (km/h); class: collector; terrain: level; DHV: 1,061
controlling criteria (v/hr); ADT: 8,844 (v/day); radius: 229.18 (m); TWW:7.20 (m)

31+694.890(31+806.850 6.50 + 0.30 7.20 + 0.00 Road value varies from Speed: 60 (km/h); class: collector; terrain: level; DHV: 1,061
controlling criteria (v/hr); ADT: 8,844 (v/day); radius: 337.03 (m); TWW:7.20 (m)

6l¢



79N 1 (d0)

Stations Traveled Way Width and Widening
Road Policy Comment Attributes
Start End (width+widening (width+widening)

33+804.780(33+921.250| 6.50 + 0.30 7.20 + 0.00 Road value varies from Speed: 60 (km/h); class: collector; terrain: level; DHV: 1,061
controlling criteria (v/hr); ADT: 8,844 (v/day); radius: 337.03 (m); TWW:7.20 (m)

35+105.636(35+319.759 6.50 + 0.30 7.20 + 0.00 Road value varies from Speed: 60 (km/h); class: collector; terrain: level; DHV: 1,061
controlling criteria (v/hr); ADT: 8,844 (v/day); radius: 301.56 (m); TWW:7.20 (m)

35+858.500(35+948.000 6.50 + 0.75 7.20 + 0.00 Road value is within controlling |Speed: 60 (km/h); class: collector; terrain: level; DHV: 1,061
criteria (v/hr); ADT: 8,844 (v/day); radius: 163.70 (m); TWW:7.20 (m)

36+727.660(36+829.730 6.50 + 0.50 7.20 + 0.00 Road value varies from Speed: 60 (km/h); class: collector; terrain: level; DHV: 1,061
controlling criteria (v/hr); ADT: 8,844 (v/day); radius: 173.62 (m); TWW:7.20 (m)

a71971 2 ananevaslnanig (Shoulder Width Policy Check)

Station Shoulder Width (meters)
Side of Road Comment Attributes
start end Road Policy
2+665.000 37+544.350 both 2.25 2.4 Road value varies from controlling Functional class=collector; ADT=8,844

criteria

(v/day) terrain=level; material=paved

0ce



m‘s"l\‘]‘ﬁ 3 Sadilds (Radius of Curve Policy Check)

Stations Radius of Curve | Effective design
(meters) speed Comment Attributes

Start End Road Policy | kilometers/hour
4+720.370 | 4+837.230 | 220.31 115 70 Road value is within controlling criteria [Superelevation=3.50 (%); design speed=60 (km/h)
7+078.887 | 7+160.831 | 190.99 75 68 Road value is within controlling criteria [Superelevation=5.20 (%); design speed=50 (km/h)
8+169.745 | 8+258.120 | 143.24 45 60 Road value is within controlling criteria |Superelevation=5.20 (%); design speed=40 (km/h)
9+788.270 | 9+924.360 106.1 45 53 Road value is within controlling criteria |Superelevation=6.00 (%); design speed=40 (km/h)
12+241.857 [12+356.857 | 121.91 45 57 Road value is within controlling criteria |Superelevation=6.00 (%); design speed=40 (km/h)
16+792.300 [17+111.150| 358.1 115 86 Road value is within controlling criteria |Superelevation=3.30 (%); design speed=60 (km/h)
20+708.767 | 20+770.520 92.41 75 51 Road value is within controlling criteria |Superelevation=6.90 (%); design speed=50 (km/h)
29+491.520 | 29+592.050 (| 229.18 115 73 Road value is within controlling criteria |Superelevation=4.30 (%); design speed=60 (km/h)
31+694.890 | 31+806.850| 337.03 115 86 Road value is within controlling criteria |Superelevation=4.30 (%); design speed=60 (km/h)
33+804.780 | 33+921.250| 337.03 115 86 Road value is within controlling criteria |Superelevation=4.30 (%); design speed=60 (km/h)
35+105.636 | 35+319.759| 301.56 115 82 Road value is within controlling criteria |Superelevation=4.70 (%); design speed=60 (km/h)
35+858.500 | 35+948.000| 163.7 115 69 Road value is within controlling criteria |Superelevation=8.80 (%); design speed=60 (km/h)
36+727.660 | 36+829.730| 173.62 115 66 Road value is within controlling criteria |Superelevation=5.80 (%); design speed=60 (km/h)

Lee



TN 4 A1aasINIEnlas (Superelevation Policy Check)

Stations Superelevation
(percent) Comment Attributes
Start End Road Policy
4+720.370 | 4+837.230 55 7.75 Road value varies from controlling criteria E2x=10.00 (%); design speed=60 (km/h); radius=220.31 (m)
7+078.887 | 7+160.831 52 6.78 Road value varies from controlling criteria E2x=10.00 (%); design speed=50 (km/h); radius=190.99 (m)
8+169.745 | 8+258.120 | 3.2 6.34 Road value varies from controlling criteria E,.ax=10.00 (%); design speed=40 (km/h); radius=143.24 (m)
9+788.270 | 9+924.360 6 7.52 Road value varies from controlling criteria E,.ax=10.00 (%); design speed=40 (km/h); radius=106.10 (m)
12+241.857 | 12+356.857| 5.2 6.94 Road value varies from controlling criteria E,.ax=10.00 (%); design speed=40 (km/h); radius=121.91 (m)
16+792.300 [17+111.150 4 5.54 Road value varies from controlling criteria E,ax=10.00 (%); design speed=60 (km/h); radius=358.10 (m)
20+708.767 | 20+770.520( 6.9 9.73 Road value varies from controlling criteria E,ax=10.00 (%); design speed=50 (km/h); radius=92.41 (m)
29+491.520 | 29+592.050( 5.3 7.56 Road value varies from controlling criteria E,.ax=10.00 (%); design speed=60 (km/h); radius=229.18 (m)
31+694.890 | 31+806.850| 4.3 5.82 Road value varies from controlling criteria E2x=10.00 (%); design speed=60 (km/h); radius=337.03 (m)
33+804.780 | 33+921.250| 4.3 5.82 Road value varies from controlling criteria E2x=10.00 (%); design speed=60 (km/h); radius=337.03 (m)
35+105.636 | 35+319.759 | 4.7 6.28 Road value varies from controlling criteria E,.ax=10.00 (%); design speed=60 (km/h); radius=301.56 (m)
35+858.500 | 35+948.000| 8.8 9.07 Road value varies from controlling criteria E,.ax=10.00 (%); design speed=60 (km/h); radius=163.70 (m)
36+727.660 [ 36+829.730( 5.8 8.83 Road value varies from controlling criteria E,.ax=10.00 (%); design speed=60 (km/h); radius=173.62 (m)
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TN 5 AN LAILUITIY (Length of Horizontal Curve Policy Check)

Computed Curve

Stations
Length (meters) Comment Attributes
Start End Road Policy

4+720.370 | 4+837.230 116.86 - Not applicable: design check not required |Functional classification=collector; design speed=60 (km/h);
Central angle=30.39 (deg)

7+078.887 | 7+160.831 81.94 - Not applicable: design check not required |Functional classification=collector; design speed=50 (km/h);
Central angle=24.58 (deg)

8+169.745 | 8+258.120 88.38 - Not applicable: design check not required [Functional classification=collector; design speed=40 (km/h);
Central angle=35.35 (deg)

9+788.270 | 9+924.360 136.09 - Not applicable: design check not required |Functional classification=collector; design speed=40 (km/h);
Central angle=73.49 (deg)

12+241.857 | 12+356.857 115 - Not applicable: design check not required |Functional classification=collector; design speed=40 (km/h);
Central angle=54.05 (deg)

16+792.300 |17+111.150| 318.85 - Not applicable: design check not required |Functional classification=collector; design speed=60 (km/h);
Central angle=51.02 (deg)

20+708.767 [20+770.520 61.75 - Not applicable: design check not required |Functional classification=collector; design speed=50 (km/h);
Central angle=38.29 (deg)

29+491.520 | 29+592.050( 100.53 - Not applicable: design check not required |Functional classification=collector; design speed=60 (km/h);
Central angle=25.13 (deg)

31+694.890 | 31+806.850 | 111.96 - Not applicable: design check not required [Functional classification=collector; design speed=60 (km/h);
Central angle=19.03 (deg)
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397N 5 (70)

Computed Curve

Stations
Length (meters) Comment Attributes
Start End Road Policy

33+804.780 | 33+921.250| 116.47 - Not applicable: design check not required [Functional classification=collector; design speed=60 (km/h);
Central angle=19.8 (deg)

35+105.636 | 35+319.759| 214.12 - Not applicable: design check not required |Functional classification=collector; design speed=60 (km/h);
Central angle=40.68 (deg)

35+858.500 | 35+948.000 89.5 - Not applicable: design check not required |Functional classification=collector; design speed=60 (km/h);
Central angle=31.33 (deg)

36+727.660 | 36+829.730| 102.07 - Not applicable: design check not required |Functional classification=collector; design speed=60 (km/h);

Central angle=33.68 (deg)

vee



ANI9N 6 ANNANATUVBILWINIGY (Vertical Tangent Grade Policy Check)

Stations Tangent Grade
(percent) Comment Attributes
Start End Road Policy
4+720.370 | 4+837.230 0 0.30 to 7.00 [Road value may vary from recommended values, |Functional classification=collector; design speed=60
check drainage (km/h); length=1,975.00 (m)
7+078.887 | 7+125.000 0.06 0.30 to 7.00 |Road value may vary from recommended values, |Functional classification=collector; design speed=50
check drainage (km/h); length=875.00 (m)
8+169.745 | 8+258.120 0.1 0.30 to 7.00 |Road value may vary from recommended values, |Functional classification=collector; design speed=40
check drainage (km/h); length=825.00 (m)
9+788.270 | 9+900.000 0.04 0.30 to 7.00 |Road value may vary from recommended values, |Functional classification=collector; design speed=40
check drainage (km/h); length=875.00 (m)
12+241.857 | 12+356.857 0.02 0.30 to 7.00 |Road value may vary from recommended values, |Functional classification=collector; design speed=40
check drainage (km/h); length=700.00 (m)
16+475.000 |17+775.000( 0.05 0.30 to 7.00 |Road value may vary from recommended values, |Functional classification=collector; design speed=60
check drainage (km/h); length=1,300.00 (m)
20+708.767 [20+770.520 0.11 0.30 to 7.00 [Road value may vary from recommended values, |Functional classification=collector; design speed=50
check drainage (km/h); length=771.50 (m)
29+491.520 | 29+500.000 0.4 0.30 to 9.00 |Road value is within controlling criteria Functional classification=collector; design speed=60
(km/h); length=25.00 (m); ADT=8,844 (v/day); additional
policy allowance=2.00 (%)

Gece



aN77197 6 (70)

Stations Tangent Grade
(percent) Comment Attributes
Start End Road Policy
29+500.000 [29+525.000 0.24 0.30 to 9.00 [Road value may vary from recommended values, |Functional classification=collector; design speed=60
check drainage (km/h); length=25.00 (m); ADT=8,844 (v/day); additional
policy allowance=2.00 (%)
29+525.000 | 29+550.000 1.32 0.30 to 9.00 |Road value is within controlling criteria Functional classification=collector; design speed=60
(km/h); length=25.00 (m); ADT=8,844 (v/day); additional
policy allowance=2.00 (%)
29+550.000 | 29+575.000 1.84 0.30 to 9.00 |Road value is within controlling criteria Functional classification=collector; design speed=60
(km/h); length=25.00 (m); ADT=8,844 (v/day); additional
policy allowance=2.00 (%)
29+575.000 [29+592.050 2.04 0.30 to 9.00 [Road value is within controlling criteria Functional classification=collector; design speed=60
(km/h); length=25.00 (m); ADT=8,844 (v/day); additional
policy allowance=2.00 (%)
31+675.000 | 31+700.000| 0.08 0.30 to 9.00 |Road value may vary from recommended values, |Functional classification=collector; design speed=60
check drainage (km/h); length=25.00 (m); ADT=8,844 (v/day); additional
policy allowance=2.00 (%)
31+700.000 | 31+725.000| 0.16 0.30 to 9.00 |Road value may vary from recommended values, |Functional classification=collector; design speed=60
check drainage (km/h); length=25.00 (m); ADT=8,844 (v/day); additional
policy allowance=2.00 (%)
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Stations Tangent Grade
(percent) Comment Attributes
Start End Road Policy
31+725.000 | 31+750.000 0 0.30 to 9.00 [Road value may vary from recommended values, |Functional classification=collector; design speed=60
check drainage (km/h); length=25.00 (m); ADT=8,844 (v/day); additional
policy allowance=2.00 (%)
31+750.000 | 31+775.000 0.16 0.30 to 9.00 |Road value may vary from recommended values, |Functional classification=collector; design speed=60
check drainage (km/h); length=25.00 (m); ADT=8,844 (v/day); additional
policy allowance=2.00 (%)
31+775.000 | 31+800.000| 0.08 0.30 to 9.00 |Road value may vary from recommended values, |Functional classification=collector; design speed=60
check drainage (km/h); length=25.00 (m); ADT=8,844 (v/day); additional
policy allowance=2.00 (%)
31+800.000 | 31+825.000 0.44 0.30 to 9.00 [Road value is within controlling criteria Functional classification=collector; design speed=60
(km/h); length=25.00 (m); ADT=8,844 (v/day); additional
policy allowance=2.00 (%)
33+800.000 | 33+825.000 1.8 0.30 to 9.00 |Road value is within controlling criteria Functional classification=collector; design speed=60
(km/h); length=25.00 (m); ADT=8,844 (v/day); additional
policy allowance=2.00 (%)
33+825.000 | 33+850.000 1.76 0.30 to 9.00 |Road value is within controlling criteria Functional classification=collector; design speed=60
(km/h); length=25.00 (m); ADT=8,844 (v/day); additional
policy allowance=2.00 (%)
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aN77197 6 (70)

Stations Tangent Grade
(percent) Comment Attributes
Start End Road Policy
33+850.000 | 33+875.000 1 0.30 to 9.00 [Road value is within controlling criteria Functional classification=collector; design speed=60
(km/h); length=25.00 (m); ADT=8,844 (v/day); additional
policy allowance=2.00 (%)
33+875.000 | 33+900.000 0.44 0.30 to 9.00 |Road value is within controlling criteria Functional classification=collector; design speed=60
(km/h); length=25.00 (m); ADT=8,844 (v/day); additional
policy allowance=2.00 (%)
33+900.000 | 33+925.000| 0.76 0.30 to 9.00 |Road value is within controlling criteria Functional classification=collector; design speed=60
(km/h); length=25.00 (m); ADT=8,844 (v/day); additional
policy allowance=2.00 (%)
35+100.000 | 35+125.000 0.04 0.30 to 9.00 [Road value may vary from recommended values, |Functional classification=collector; design speed=60
check drainage (km/h); length=25.00 (m); ADT=8,844 (v/day); additional
policy allowance=2.00 (%)
35+125.000 | 35+150.000 0.6 0.30 to 9.00 |Road value is within controlling criteria Functional classification=collector; design speed=60
(km/h); length=25.00 (m); ADT=8,844 (v/day); additional
policy allowance=2.00 (%)
35+150.000 | 35+175.000| 0.32 0.30 to 9.00 |Road value is within controlling criteria Functional classification=collector; design speed=60
(km/h); length=25.00 (m); ADT=8,844 (v/day); additional
policy allowance=2.00 (%)
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aN77197 6 (70)

Stations Tangent Grade
(percent) Comment Attributes
Start End Road Policy
35+175.000 | 35+200.000 0.12 0.30 to 9.00 [Road value may vary from recommended values, |Functional classification=collector; design speed=60
check drainage (km/h); length=25.00 (m); ADT=8,844 (v/day); additional
policy allowance=2.00 (%)
35+200.000 | 35+225.000| 0.16 0.30 to 9.00 |Road value may vary from recommended values, |Functional classification=collector; design speed=60
check drainage (km/h); length=25.00 (m); ADT=8,844 (v/day); additional
policy allowance=2.00 (%)
35+225.000 | 35+250.000| 0.08 0.30 to 9.00 |Road value may vary from recommended values, |Functional classification=collector; design speed=60
check drainage (km/h); length=25.00 (m); ADT=8,844 (v/day); additional
policy allowance=2.00 (%)
35+250.000 | 35+275.000 0.32 0.30 to 9.00 [Road value is within controlling criteria Functional classification=collector; design speed=60
(km/h); length=25.00 (m); ADT=8,844 (v/day); additional
policy allowance=2.00 (%)
35+275.000 | 35+300.000 0.4 0.30 to 9.00 |Road value is within controlling criteria Functional classification=collector; design speed=60
(km/h); length=25.00 (m); ADT=8,844 (v/day); additional
policy allowance=2.00 (%)
35+300.000 | 35+325.000| 0.16 0.30 to 9.00 |Road value may vary from recommended values, |Functional classification=collector; design speed=60
check drainage (km/h); length=25.00 (m); ADT=8,844 (v/day); additional
policy allowance=2.00 (%)
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Stations Tangent Grade
(percent) Comment Attributes
Start End Road Policy
35+850.000 | 35+875.000 0.08 0.30 to 9.00 [Road value may vary from recommended values, |Functional classification=collector; design speed=60
check drainage (km/h); length=25.00 (m); ADT=8,844 (v/day); additional
policy allowance=2.00 (%)
35+875.000 | 35+900.000| 0.04 0.30 to 9.00 |Road value may vary from recommended values, |Functional classification=collector; design speed=60
check drainage (km/h); length=25.00 (m); ADT=8,844 (v/day); additional
policy allowance=2.00 (%)
35+900.000 | 35+925.000 0 0.30 to 9.00 |Road value may vary from recommended values, |Functional classification=collector; design speed=60
check drainage (km/h); length=25.00 (m); ADT=8,844 (v/day); additional
policy allowance=2.00 (%)
35+925.000 | 35+950.000 0.04 0.30 to 9.00 [Road value may vary from recommended values, |Functional classification=collector; design speed=60
check drainage (km/h); length=25.00 (m); ADT=8,844 (v/day); additional
policy allowance=2.00 (%)
36+727.660 | 36+750.000 0.32 0.30 to 9.00 |Road value is within controlling criteria Functional classification=collector; design speed=60
(km/h); length=25.00 (m); ADT=8,844 (v/day); additional
policy allowance=2.00 (%)
36+750.000 | 36+775.000| 0.32 0.30 to 9.00 |Road value is within controlling criteria Functional classification=collector; design speed=60
(km/h); length=25.00 (m); ADT=8,844 (v/day); additional
policy allowance=2.00 (%)
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aN77197 6 (70)

Stations Tangent Grade
(percent) Comment Attributes
Start End Road Policy
36+775.000 | 36+800.000 0.28 0.30 to 9.00 [Road value may vary from recommended values, |Functional classification=collector; design speed=60
check drainage (km/h); length=25.00 (m); ADT=8,844 (v/day); additional
policy allowance=2.00 (%)
36+800.000 | 36+825.000 0.44 0.30 to 9.00 |Road value is within controlling criteria Functional classification=collector; design speed=60
(km/h); length=25.00 (m); ADT=8,844 (v/day); additional
policy allowance=2.00 (%)
36+825.000 | 36+829.730 0.2 0.30 to 9.00 |Road value may vary from recommended values, |Functional classification=collector; design speed=60

check drainage

(km/h); length=25.00 (m); ADT=8,844 (v/day); additional

policy allowance=2.00 (%)

Lec



ANT1N 7 aNulaaneae (Vertical Curvature Policy Check)

Stations K value (meters/%)| effective design speed
Comment Attributes
Start End Road Policy kilometers/hour
2+875.000 | 5+375.000 Road value varies from controlling 2+875.000 to 4+850.000, grade=0.00 (%);
criteria, grade break without a curve |4+850.000 to 5+375.000, grade=0.15 (%)
6+250.000 | 7+525.000 Road value varies from controlling 6+250.000 to 7+125.000, grade=0.06 (%);
criteria, grade break without a curve |7+125.000 to 7+525.000, grade=0.00 (%)
7+125.000 | 8+350.000 Road value varies from controlling 7+125.000 to 7+525.000, grade=0.00 (%);
criteria, grade break without a curve |7+525.000 to 8+350.000, grade=0.11 (%)
7+125.000 | 8+350.000 Road value varies from controlling 7+125.000 to 7+525.000, grade=0.00 (%);
criteria, grade break without a curve |7+525.000 to 8+350.000, grade=0.11 (%)
8+925.000 | 9+025.000 | 625 11 130 Road value is within controlling criteria|Design speed=60 (km/h); type of curve=crest;
project type=reconstruction
9+900.000 [10+000.000 | 454.55 9 130 Road value is within controlling criteria|Design speed=40 (km/h); type of curve=sag;
project type=reconstruction
11+100.000 | 12+575.000 Road value varies from controlling 11+100.000 to 11+875.000, grade=0.00 (%);
criteria, grade break without a curve |11+875.000 to 12+575.000, grade=0.02 (%)
11+875.000 | 13+375.000 Road value varies from controlling 11+875.000 to 12+575.000, grade=0.02 (%);
criteria, grade break without a curve [12+575.000 to 13+375.000, grade=0.12 (%)
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39N 7 (d0)

Stations

K value (meters/%)

effective design speed

Start

End

Road

Policy

kilometers/hour

Comment

Attributes

16+200.000

17+775.000

Road value varies from controlling

criteria, grade break without a curve

16+200.000 to 16+475.000, grade=0.22 (%)

19+225.000

21+096.500

Road value varies from controlling

criteria, grade break without a curve

(o)
16+475.000 to 17+775.000, grade=0.05 (%
19+225.000 to 20+325.000, grade=0.14 (%)

(%);
(%)
(%);
20+325.000 to 21+096.500, grade=0.11 (%)

20+325.000

21+142.100

Road value varies from controlling

criteria, grade break without a curve

20+325.000 to 21+096.500, grade=0.11 (%);
21+096.500 to 21+142.100, grade=0.00 (%)

29+375.000

29+425.000

Road value varies from controlling

criteria, grade break without a curve

29+375.000 to 29+400.000, grade=-0.28 (%);
29+400.000 to 29+425.000, grade=0.08 (%)

29+400.000

29+450.000

Road value varies from controlling

criteria, grade break without a curve

29+400.000 to 29+425.000, grade=0.08 (%);
29+425.000 to 29+450.000, grade=0.04 (%)

29+425.000

29+475.000

Road value varies from controlling

criteria, grade break without a curve

29+425.000 to 29+450.000, grade=0.04 (%);
29+450.000 to 29+475.000, grade=-0.20 (%)

29+450.000

29+500.000

Road value varies from controlling

criteria, grade break without a curve

29+450.000 to 29+475.000, grade=-0.20 (%);
29+475.000 to 29+500.000, grade=-0.40 (%)

29+475.000

29+525.000

Road value varies from controlling

criteria, grade break without a curve

29+475.000 to 29+500.000, grade=-0.40 (%);
29+500.000 to 29+525.000, grade=0.24 (%)
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39N 7 (d0)

Stations

K value (meters/%)

effective design speed

Start

End

Road

Policy

kilometers/hour

Comment

Attributes

29+500.000

29+550.000

Road value varies from controlling

criteria, grade break without a curve

29+500.000 to 29+525.000, grade=0.24 (%);
29+525.000 to 29+550.000, grade=1.32 (%)

29+525.000

29+575.000

Road value varies from controlling

criteria, grade break without a curve

29+525.000 to 29+550.000, grade=1.32 (%);
29+550.000 to 29+575.000, grade=1.84 (%)

29+550.000

29+600.000

Road value varies from controlling

criteria, grade break without a curve

29+550.000 to 29+575.000, grade=1.84 (%);
29+575.000 to 29+600.000, grade=2.04 (%)

29+575.000

29+625.000

Road value varies from controlling

criteria, grade break without a curve

29+575.000 to 29+600.000, grade=2.04 (%);
29+600.000 to 29+625.000, grade=1.40 (%)

31+675.000

31+725.000

Road value varies from controlling

criteria, grade break without a curve

31+675.000 to 31+700.000, grade=0.08 (%);
31+700.000 to 31+725.000, grade=-0.16 (%)

31+700.000

31+750.000

Road value varies from controlling

criteria, grade break without a curve

31+700.000 to 31+725.000, grade=-0.16 (%);
31+725.000 to 31+750.000, grade=0.00 (%)

31+725.000

31+775.000

Road value varies from controlling

criteria, grade break without a curve

31+725.000 to 31+750.000, grade=0.00 (%);
31+750.000 to 31+775.000, grade=0.16 (%)

31+750.000

31+800.000

Road value varies from controlling

criteria, grade break without a curve

31+750.000 to 31+775.000, grade=0.16 (%);
31+775.000 to 31+800.000, grade=0.08 (%)
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39N 7 (d0)

Stations

K value (meters/%)

effective design speed

Start

End

Road

Policy

kilometers/hour

Comment

Attributes

31+775.000

31+825.000

Road value varies from controlling

criteria, grade break without a curve

31+775.000 to 31+800.000, grade=0.08 (%);
31+800.000 to 31+825.000, grade=-0.44 (%)

35+100.000

35+150.000

Road value varies from controlling

criteria, grade break without a curve

35+100.000 to 35+125.000, grade=0.04 (%);
35+125.000 to 35+150.000, grade=-0.60 (%)

35+125.000

35+175.000

Road value varies from controlling

criteria, grade break without a curve

35+125.000 to 35+150.000, grade=-0.60 (%);
35+150.000 to 35+175.000, grade=0.32 (%)

35+150.000

35+200.000

Road value varies from controlling

criteria, grade break without a curve

35+150.000 to 35+175.000, grade=0.32 (%);
35+175.000 to 35+200.000, grade=0.12 (%)

35+175.000

35+225.000

Road value varies from controlling

criteria, grade break without a curve

35+175.000 to 35+200.000, grade=0.12 (%);
35+200.000 to 35+225.000, grade=0.16 (%)

35+200.000

35+250.000

Road value varies from controlling

criteria, grade break without a curve

35+200.000 to 35+225.000, grade=0.16 (%);
35+225.000 to 35+250.000, grade=-0.08 (%)

35+225.000

35+275.000

Road value varies from controlling

criteria, grade break without a curve

35+225.000 to 35+250.000, grade=-0.08 (%);
35+250.000 to 35+275.000, grade=0.32 (%)

35+250.000

35+300.000

Road value varies from controlling

criteria, grade break without a curve

35+250.000 to 35+275.000, grade=0.32 (%);
35+275.000 to 35+300.000, grade=0.40 (%)

35+275.000

35+325.000

Road value varies from controlling

criteria, grade break without a curve

35+275.000 to 35+300.000, grade=0.40 (%);
35+300.000 to 35+325.000, grade=-0.16 (%)

Ggee



39N 7 (d0)

Stations K value (meters/%)| effective design speed
Comment Attributes
Start End Road Policy kilometers/hour

35+825.000 | 35+875.000 Road value varies from controlling 35+825.000 to 35+850.000, grade=-0.04 (%);
criteria, grade break without a curve |35+850.000 to 35+875.000, grade=0.08 (%)

35+850.000 | 35+900.000 Road value varies from controlling 35+850.000 to 35+875.000, grade=0.08 (%);
criteria, grade break without a curve |35+875.000 to 35+900.000, grade=0.04 (%)

35+875.000 | 35+925.000 Road value varies from controlling 35+875.000 to 35+900.000, grade=0.04 (%);
criteria, grade break without a curve |35+900.000 to 35+925.000, grade=0.00 (%)

35+900.000 | 35+950.000 Road value varies from controlling 35+900.000 to 35+925.000, grade=0.00 (%);
criteria, grade break without a curve |35+925.000 to 35+950.000, grade=0.04 (%)

36+675.000 | 36+725.000 Road value varies from controlling 36+675.000 to 36+700.000, grade=-0.32 (%);
criteria, grade break without a curve |36+700.000 to 36+725.000, grade=-0.28 (%)

36+700.000 | 36+750.000 Road value varies from controlling 36+700.000 to 36+725.000, grade=-0.28 (%);
criteria, grade break without a curve |36+725.000 to 36+750.000, grade=-0.32 (%)

36+750.000 | 36+800.000 Road value varies from controlling 36+750.000 to 36+775.000, grade=-0.32 (%);
criteria, grade break without a curve |36+775.000 to 36+800.000, grade=-0.28 (%)

36+775.000 | 36+825.000 Road value varies from controlling 36+775.000 to 36+800.000, grade=-0.28 (%);
criteria, grade break without a curve [36+800.000 to 36+825.000, grade=-0.44 (%)
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39N 7 (d0)

Stations K value (meters/%)| effective design speed
Comment Attributes
Start End Road Policy kilometers/hour
36+800.000 | 36+850.000 Road value varies from controlling 36+800.000 to 36+825.000, grade=-0.44 (%);
criteria, grade break without a curve  |36+825.000 to 36+850.000, grade=-0.20 (%)
36+825.000 | 36+875.000 Road value varies from controlling 36+825.000 to 36+850.000, grade=-0.20 (%);

criteria, grade break without a curve

36+850.000 to 36+875.000, grade=-0.08 (%)
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a3197 8 TeUzUBI AU IMTUNINLA (Stopping Sight Distance Policy Check)

Stations Stopping Sight Distance (meters)
Direction of Travel Comment Attributes
Start End Road (minimum) Policy
2+753.000 | 7+077.000 | Decreasing Stations >>85 85 Road value is within controlling criteria Design speed=50 (km/h)
7+079.000 | 7+159.000 | Decreasing Stations >>65 65 Road value is within controlling criteria Design speed=60 (km/h)
8+171.000 | 8+257.000 | Decreasing Stations >>50 50 Road value is within controlling criteria Design speed=60 (km/h)
9+789.000 | 9+923.000 | Decreasing Stations >>50 50 Road value is within controlling criteria Design speed=60 (km/h)
12+243.000 | 12+355.000 | Decreasing Stations >>50 50 Road value is within controlling criteria Design speed=60 (km/h)
15+519.000 | 20+707.000 | Decreasing Stations >>85 85 Road value is within controlling criteria Design speed=50 (km/h)
20+709.000 | 20+769.000 | Decreasing Stations >>65 65 Road value is within controlling criteria Design speed=60 (km/h)
20+805.000 | 31+445.000 | Decreasing Stations >>85 85 Road value is within controlling criteria Design speed=60 (km/h)
31+483.000 | 36+447.000 | Decreasing Stations >>85 85 Road value is within controlling criteria Design speed=40 (km/h)
36+643.000 | 37+543.000 | Decreasing Stations >>85 85 Road value is within controlling criteria Design speed=60 (km/h)
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2)

Stations Stopping Sight Distance (meters)
Direction of Travel Comment Attributes
Start End Road (minimum) Policy
2+665.000 | 7+057.000 Increasing Stations >>85 85 Road value is within controlling criteria Design speed=60 (km/h)
7+079.000 | 7+159.000 Increasing Stations >>65 65 Road value is within controlling criteria Design speed=60 (km/h)
8+171.000 | 8+257.000 Increasing Stations >>50 50 Road value is within controlling criteria Design speed=60 (km/h)
9+789.000 | 9+923.000 Increasing Stations >>50 50 Road value is within controlling criteria Design speed=60 (km/h)
12+243.000 | 12+355.000 | Increasing Stations >>50 50 Road value is within controlling criteria Design speed=60 (km/h)
15+519.000 | 20+655.000 | Increasing Stations >>85 85 Road value is within controlling criteria Design speed=60 (km/h)
20+709.000 | 20+769.000 | Increasing Stations >>65 65 Road value is within controlling criteria Design speed=60 (km/h)
20+771.000 | 31+363.000 | Increasing Stations >>85 85 Road value is within controlling criteria Design speed=60 (km/h)
31+389.000 | 35+825.000 | Increasing Stations >>85 85 Road value is within controlling criteria Design speed=60 (km/h)
35+887.000 | 36+447.000 | Increasing Stations >>85 85 Road value is within controlling criteria Design speed=40 (km/h)
36+621.000 | 36+697.000 | Increasing Stations >>85 85 Road value is within controlling criteria Design speed=60 (km/h)
36+699.000 | 36+765.000 | Increasing Stations 78 85 Road value may vary from recommended |Design speed=60 (km/h)
values, check obstructions beyond
Obstruction Offset; source of SD limitation
is horizontal alignment
36+767.000 | 37+455.000 | Increasing Stations >>85 85 Road value is within controlling criteria Design speed=60 (km/h)
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N3N 9 TULUBILABRIRILNNILDY (Passing Sight Distance Policy Check)

Stations Direction of | Passing Sight Distance (meters)
Comment Attributes
Start End Travel Road (minimum) Policy
3+485.000 4+769.000 Decreasing >>410 410 Road value is within recommended values Design speed=60
Stations (km/h)
4+771.000 5+369.000 Decreasing 100 410 Road value may vary from recommended values, check Design speed=60
Stations obstructions beyond Obstruction Offset; source of SD (km/h)
limitation is horizontal alignment
7+079.000 7+159.000 Decreasing 96 345 Road value may vary from recommended values, check Design speed=60
Stations obstructions beyond Obstruction Offset; source of SD (km/h)
limitation is horizontal alignment
8+171.000 8+211.000 Decreasing >>270 270 Road value is within recommended values Design speed=40
Stations (km/h)
8+213.000 8+257.000 Decreasing 84 270 Road value may vary from recommended values, check Design speed=60
Stations obstructions beyond Obstruction Offset; source of SD (km/h)
limitation is horizontal alignment
9+789.000 9+831.000 Decreasing >>270 270 Road value is within recommended values Design speed=40
Stations (km/h)
9+833.000 9+923.000 Decreasing 70 270 Road value may vary from recommended values, check Design speed=60
Stations obstructions beyond Obstruction Offset; source of SD (km/h)
limitation is horizontal alignment

ove



a3 9 (div)

Stations Direction of | Passing Sight Distance (meters)
Comment Attributes
Start End Travel Road (minimum) Policy
12+243.000 | 12+279.000 | Decreasing >>270 270 Road value is within recommended values Design speed=40
Stations (km/h)
12+281.000 | 12+355.000 | Decreasing 80 270 Road value may vary from recommended values, check Design speed=60
Stations obstructions beyond Obstruction Offset; source of SD (km/h)
limitation is horizontal alignment
16+079.000 | 16+855.000 | Decreasing >>410 410 Road value is within recommended values Design speed=60
Stations (km/h)
16+857.000 | 17+819.000 | Decreasing 128 410 Road value may vary from recommended values, check Design speed=60
Stations obstructions beyond Obstruction Offset; source of SD (km/h)
limitation is horizontal alignment
20+709.000 [ 20+747.000 | Decreasing >>345 345 Road value is within recommended values Design speed=50
Stations (km/h)
20+749.000 [ 20+769.000 | Decreasing 70 345 Road value may vary from recommended values, check Design speed=60
Stations obstructions beyond Obstruction Offset; source of SD (km/h)
limitation is horizontal alignment
29+155.000 | 29+973.000 | Decreasing 102 410 Road value may vary from recommended values, check Design speed=60
Stations obstructions beyond Obstruction Offset; source of SD (km/h)
limitation is horizontal alignment
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Stations Direction of | Passing Sight Distance (meters)
Comment Attributes
Start End Travel Road (minimum) Policy
31+453.000 [ 32+141.000 | Decreasing 74 410 Road value varies from recommended values; source of SD |Design speed=60
Stations limitation is vertical alignment (km/h)
33+665.000 [ 33+879.000 | Decreasing >>410 410 Road value is within recommended values Design speed=60
Stations (km/h)
33+881.000 [ 34+267.000 | Decreasing 124 410 Road value may vary from recommended values, check Design speed=60
Stations obstructions beyond Obstruction Offset; source of SD (km/h)
limitation is horizontal alignment
34+773.000 [ 35+109.000 | Decreasing 326 410 Road value may vary from recommended values, check Design speed=60
Stations obstructions beyond Obstruction Offset; source of SD (km/h)
limitation is horizontal alignment
35+111.000 [ 35+179.000 | Decreasing >>410 410 Road value is within recommended values Design speed=60
Stations (km/h)
35+181.000 [ 35+671.000 | Decreasing 116 410 Road value may vary from recommended values, check Design speed=60
Stations obstructions beyond Obstruction Offset; source of SD (km/h)
limitation is horizontal alignment
35+705.000 | 36+447.000 | Decreasing 86 410 Road value may vary from recommended values, check Design speed=40
Stations obstructions beyond Obstruction Offset; source of SD (km/h)
limitation is horizontal alignment
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Stations Direction of | Passing Sight Distance (meters)
Comment Attributes
Start End Travel Road (minimum) Policy
36+621.000 [ 37+197.000 | Decreasing 88 410 Road value may vary from recommended values, check Design speed=60
Stations obstructions beyond Obstruction Offset; source of SD (km/h)
limitation is horizontal alignment
4+359.000 4+957.000 Increasing 100 410 Road value may vary from recommended values, check Design speed=60
Stations obstructions beyond Obstruction Offset; source of SD (km/h)
limitation is horizontal alignment
7+079.000 7+113.000 Increasing 98 345 Road value may vary from recommended values, check Design speed=50
Stations obstructions beyond Obstruction Offset; source of SD (km/h)
limitation is horizontal alignment
7+115.000 7+159.000 Increasing >>345 345 Road value is within recommended values Design speed=60
Stations (km/h)
8+171.000 8+207.000 Increasing 80 270 Road value may vary from recommended values, check Design speed=40
Stations obstructions beyond Obstruction Offset; source of SD (km/h)
limitation is horizontal alignment
8+209.000 8+257.000 Increasing >>270 270 Road value is within recommended values Design speed=60
Stations (km/h)
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Stations Direction of | Passing Sight Distance (meters)
Comment Attributes
Start End Travel Road (minimum) Policy
9+789.000 9+887.000 Increasing 76 270 Road value may vary from recommended values, check Design speed=40
Stations obstructions beyond Obstruction Offset; source of SD (km/h)
limitation is horizontal alignment
9+889.000 9+923.000 Increasing >>270 270 Road value is within recommended values Design speed=60
Stations (km/h)
12+243.000 | 12+331.000 Increasing 74 270 Road value may vary from recommended values, check Design speed=40
Stations obstructions beyond Obstruction Offset; source of SD (km/h)
limitation is horizontal alignment
12+333.000 | 12+355.000 Increasing >>270 270 Road value is within recommended values Design speed=60
Stations (km/h)
16+445.000 | 17+431.000 Increasing 128 410 Road value may vary from recommended values, check Design speed=60
Stations obstructions beyond Obstruction Offset; source of SD (km/h)
limitation is horizontal alignment
20+709.000 | 20+737.000 Increasing 76 345 Road value may vary from recommended values, check Design speed=50
Stations obstructions beyond Obstruction Offset; source of SD (km/h)
limitation is horizontal alignment
20+739.000 | 20+769.000 Increasing >>345 345 Road value is within recommended values Design speed=60
Stations (km/h)
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Stations Direction of | Passing Sight Distance (meters)
Comment Attributes
Start End Travel Road (minimum) Policy
28+743.000 [ 29+561.000 Increasing 102 410 Road value may vary from recommended values, check Design speed=60
Stations obstructions beyond Obstruction Offset; source of SD (km/h)
limitation is horizontal alignment
29+563.000 [ 29+601.000 Increasing >>410 410 Road value is within recommended values Design speed=60
Stations (km/h)
31+079.000 | 31+729.000 Increasing 84 410 Road value varies from recommended values; source of SD |Design speed=60
Stations limitation is vertical alignment (km/h)
31+731.000 | 32+285.000 Increasing >>410 410 Road value is within recommended values Design speed=60
Stations (km/h)
33+469.000 [ 33+855.000 Increasing 124 410 Road value may vary from recommended values, check Design speed=60
Stations obstructions beyond Obstruction Offset; source of SD (km/h)
limitation is horizontal alignment
33+857.000 [ 34+359.000 Increasing >>410 410 Road value is within recommended values Design speed=60
Stations (km/h)
34+771.000 [ 35+259.000 Increasing 116 410 Road value may vary from recommended values, check Design speed=60
Stations obstructions beyond Obstruction Offset; source of SD (km/h)
limitation is horizontal alignment
35+261.000 | 35+293.000 Increasing >>410 410 Road value is within recommended values Design speed=60
Stations (km/h)
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Stations Direction of | Passing Sight Distance (meters)
Comment Attributes
Start End Travel Road (minimum) Policy
35+295.000 [ 36+447.000 Increasing 88 410 Road value may vary from recommended values, check Design speed=40
Stations obstructions beyond Obstruction Offset; source of SD (km/h)
limitation is horizontal alignment
36+621.000 [ 36+783.000 Increasing 90 410 Road value may vary from recommended values, check Design speed=60
Stations obstructions beyond Obstruction Offset; source of SD (km/h)
limitation is horizontal alignment
36+785.000 | 37+129.000 Increasing >>410 410 Road value is within recommended values Design speed=60
Stations (km/h)
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